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Introduction 

Financial Management Training Manual Overview 
This manual will aid WIC personnel in learning about the function and use of the Financial Management 
component of the SPIRIT WIC System.  The Financial Management application is a comprehensive solution to 
help WIC personnel manage WIC program finances.  Major functions of the Financial Management application 
include the following: 

• Journal – Used to store and access journal entries that track WIC program finances. 

• Rebate Suppliers – Used to store and access information about WIC program rebate suppliers. 

• Reports – Used to generate reports and spreadsheets. 

Manual Content 

This manual includes the following components organized in the order indicated: 

• Table of Contents – Lists every functional screen in the application and every training scenario available. 
 The TOC is organized in roughly the same way as the application, with content grouped together by 
application area.  Use the TOC to look up topics that cover application screens and common scenarios, 
and browse by application area. 

• Training Manual Overview – Outlines the content of this manual and explains how this manual can be 
used.  It includes information about the general structure of this manual and tips to help you get the most 
out of it. 

• Main Body – Covers the screens available within the application and describes the screen elements 
available on those screens.  The Main Body of this manual functions as a software manual and user 
reference.  If you need to know the purpose of a specific screen or screen element, what screen to use for a 
specific task, or how a specific screen element is used, reference the main body of this manual. 

• Training Scenarios – Covers situations that one might encounter in an average day at a clinic.  Each 
scenario walks you through an entire process.  Scenarios connect the individual tasks necessary to complete 
a process.  The scenarios were written and organized to facilitate an instructor-led training session, but the 
scenarios can be used as reference guides after your training is complete. 

• Glossary – Lists particularly difficult or specialized words used in this help file along with their definitions. 
 If you are unsure about the meaning of a word used within this help file, you can look up its definition in 
the Glossary. 

• Index – Lists every functional screen in the application and every training scenario available.  In many 
cases, the Index lists topics more than once, with several alternate entries for each topic.  These alternate 
entries make the Index a powerful tool for finding information quickly and easily. 

Conventions and Features 

This manual follows certain conventions that make it easy for you to use the materials presented and includes the 
following features that make it easy for you to identify similar information from one topic to another: 

• Each chapter groups topics together by application area, so you'll know what you can expect to see. 

• Each screen topic and training scenario begins by explaining what it covers, so you'll know from the start 
what you'll be learning. 

1 



F I N A N C I A L  M A N A G E M E N T  T R A I N I N G  M A N U A L  

• Each screen element (an object or control displayed on an application screen) is referenced with bold, blue 
lettering to help it stand out on the page, so that you can identify it more easily. 

Pictures of application screens are included throughout this manual.  The pictures are included for your reference, 
to help familiarize you with the screens.  Any data displayed in the pictures is irrelevant and can be ignored. 

Navigational icons are displayed in the left-hand margin of the manual to help you find specific types of 
information quickly.  The icons and their definitions are displayed below: 

 Screen Access Icons 

 
The application-screen-and-green-arrow icon displays to the left of paragraphs that provide information 
about how to access a specific application screen.  These paragraphs inform you where you can access the 
application screen and what steps must be taken to display it.  This type of information is included 
immediately after the introduction in topics that cover a specific application screen. 

 

 NOTE ICONS 

 
The notepad-and-pencil icon displays to the left of paragraphs that provide additional, and usually more 
detailed, information about the application.  Sometimes the notes give you additional information about the 
screen you're working with, and sometimes the notes inform you where to find additional information 
elsewhere within this manual.  Either way, it is well worth your time to watch for these helpful icons. 

Pay attention to the navigational icons as you read through this manual, and they'll help you locate important 
details that you might otherwise overlook.  What's more, after you've completed the training, the icons will serve 
as signposts, quickly guiding you to the information you need. 

Using This Manual 

This manual can be used as a reference guide for the software or as a training manual.  If you need a training 
scenario to guide you through a system processes, step-by-step, simply reference the Training Scenarios 
chapter.  If you need help with a specific application screen, screen element, or task, you will find those topics in 
the main body of this manual.  You can use either of the following methods to find the topic you're looking for: 

• The Table of Contents – Use the table of contents (TOC) to find a specific topic by browsing for it.  The 
TOC organizes topics in roughly the same way that you might encounter them while navigating through 
the application.  This method allows you to get a better feel for the application since it shows you related 
topics found in the same area of the application  However, for this method to be effective, you need to 
have some idea of where the application screen you're looking for is located within the application. 

• The Index – Use the Index to find a specific topic by looking up the name of the screen or a task that can 
be performed on the screen.  This method of finding a topic tends to be quicker and more effective since 
you can lookup a screen name in the Index and quickly jump to the appropriate topic without having any 
idea where the screen is located within the application. 

Once you've located the topic for an application screen, you'll need to know how to get to that screen from your 
current location within the application.  This is when the Screen Access information, located after each topic's 
introduction, is most helpful.  In the case of the Generate Reports screen, you would see the following Screen 
Access text displayed immediately after the introductory paragraph: 

 
To access this screen:  Display the Financial Management screen, and then do one of the following: 
• On the File menu, and then click Generate Reports. 
• Click the System Outputs toolbar button (pictured below), and then click Generate Reports. 
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As you can see, the text explains how to display the screen.  Now, if you were familiar with the application, you 
would know that the Financial Management screen is the first screen displayed after the Login process is 
complete, and would be comfortable starting the task of generating a report from that screen.  It would be as 
simple as putting the steps outlined in the Screen Access text together: 

1. Display the Financial Management screen. 

2. On the File menu, point to System Outputs, and then click Generate Reports.  (Alternately, you could 
click the Reports toolbar button as indicated in the Screen Access text.)  The Generate Reports screen 
would display. 

Once the Generate Reports screen was displayed, you would simply use the information included in the 
Generate Reports topic to follow the task through to completion. 

 
NOTE:  The majority of the information included in this manual is also included in the help file for the 
application.  You can access any online training scenarios and help topics for application screens that are 
included in the manual using the help file instead.  The TOC and Index included in the help file are 
automated, so all references link back to the appropriate topics like the links on a Web page.  In the 
previous example, if you were using the help file, you would do the following: 
• Press the F1 key to display the help topic for the current application screen. 
• Click the Index tab. 
• Lookup Generate Reports in the index. 
• Select the Generate Reports index entry. 
• Click Display to display the Generate Reports topic. 
• Follow the Screen Access instructions to display the Generate Reports screen. 

Once the Generate Reports screen was displayed, you would use the information included in the 
Generate Reports topic to complete the task. 
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Working with Journals 
The Financial Management [Journal] screen is used to manage journal entries. 

 
Financial Management [Journal] Screen 

 
To access this screen:   
• On the View menu, click Journal as necessary (This is the first screen displayed after the application 

is started). 

A Menu Bar and a Toolbar are displayed at the top of the screen.  The menu bar provides access to functions 
that are not available on the main screen.  Click a menu to display the list of available commands, and then click a 
command to activate its functionality.  The toolbar provides access to frequently used functions, usually with a 
single click.  Click a toolbar button to activate its functionality.  For more information about the menu bar, see 
the The Financial Management [Journal] Menu Bar topic, and for more information about the toolbar, see 
the Financial Management Toolbar topic. 

Screen Elements: 

Journal Entries – Click a journal entry record in this table to select it.  This table displays journal entries based 
upon the criteria specified on the Filter Journal View screen. 

 
NOTE:  On the View menu, click Refresh View to refresh the list of journal entries displayed in the 
table. 
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The Financial Management [Journal] Menu Bar 
The Financial Management [Journal] Menu Bar provides access to functions on the Journal view of the 
Financial Management screen.  Depending on your permission level and the client's current status, some 
commands on the menus may not be available for selection. 

Screen Elements: 

File – Click this menu to access commands that are common to the main screens within the application.  The 
following commands are displayed: 

• Filter Journal View – Click this command to filter the list of journals. 

• System Tools – Point to this sub-menu to display the following system tools: 

o Change Password – Click this command to change the password of the currently logged on user. 

o Set Default Printers – Click this command to specify the default printers for the currently logged 
on user. 

• Reports – Click this command to generate reports. 

• Exit – Click this command to exit the application. 

Journal – Click this menu to access journal commands for the Financial Management screen.  The following 
commands are displayed: 

• Add – Click this command to add a journal. 

• Edit – Click this command to edit a journal selected in the Journal Entries table. 

• Details – Click this command to view a journal selected in the Journal Entries table. 

• Financial Account Inquiry – Click this button to access the financial account inquiry. 

• Accounting Schedule List – Click this button to manage accounting schedules. 

• Funds List – Click this button to manage funds. 

• Financial Accounts List – Click this button to manage financial accounts. 

• Natural Accounts List – Click this button to manage natural accounts. 

• Financial Statement List – Click this button to manage financial statements. 

View – Click this menu to access commands that change the view of the Financial Management screen.  The 
following commands are displayed: 

• Journal – Click this command to display the Journal view of the Financial Management screen. 

• Rebate Suppliers – Click this command to display the Rebate Supplier view of the Financial 
Management screen. 

• Refresh View – Click this command to refresh the view of the Financial Management screen. 

Activities – Click this menu to access financial management activities.  The following command is displayed: 

• Bank Exceptions – Click this command to manage bank exceptions. 

Help – Click this menu to access user assistance information.  The following commands are displayed: 

• Help on Screen – Click this command to display the topic for the Financial Management screen. 

• Financial Management Help Topics – Click this command to display the help overview. 
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• About – Click this command to display information about the application itself. 
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The Financial Management Toolbar 
The Financial Management Toolbar provides access to frequently used functions on the Journal view of the 
Financial Management screen.  Depending on your permission level and the client's current status, some 
toolbar buttons may not be available for selection. 

 
The Financial Management Toolbar 

Screen Elements: 

 
Filter Journal View – Click this toolbar button to filter the list of journals.  This toolbar button is only 
available in Journal view. 

 
Reports – Click the this toolbar button to generate reports. 

 
System Tools – Click the down-arrow on this toolbar button, and then click an option on the menu: 
• Change Password – Click this command to change the password of the currently logged on user. 
• Set Default Printers – Click this command to specify the default printers for the currently logged 

on user. 

 
Exit Application – Click this toolbar button to exit the application. 

 
Add Journal – Click this toolbar button to add a journal.  This toolbar button is only available in Journal 
view. 
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Filter Journal View 
The Filter Journal View screen is used to filter the Journal Entries table on the Financial Management 
[Journal] screen. 

 
Filter Journal View Screen 

 
To access this screen:   
• Display the Financial Management [Journal] screen > Click the Filter Journal View toolbar 

button (pictured below). 

 

Screen Elements: 

Complete the following information to specify the filter criteria: 

• Select by Transaction Date – Select this check box to search for journal entries with a transaction date 
that falls within a specified range, and then complete the following information: 

o Starting Date – Enter or select the starting date of the date range. 

o Ending Date – Enter or select the starting date of the date range. 

• Journal ID – Enter the journal identification number to search for a journal entry with that ID. 

• Accounting Period – Select an accounting period to search for journal entries from that accounting 
period. 

• Journal Type – Select a journal type to search for journal entries of that journal type. 

• Fund – Select a fund to search for journal entries associated with that fund. 

• Financial Account – Select a financial account to search for journal entries associated with that financial 
account. 
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• Natural Account – Select a natural account to search for journal entries associated with that natural 
account. 

• Agency – Select an agency to search for journal entries associated with that agency. 

• Status – Select a status to search for journal entries of that status. 

• Value Type – Select a value type to search for journal entries of that value type. 

• Created By – Select a staff member to search for journal entries created by that staff member. 

• Sort by Transaction Date – Select this check box to sort journal entries by their transaction dates. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Journal menu 

Add, Edit, and Details 
Journal 

The Journal screen is used to manage journal entries, and can be displayed in Add, Edit, or Detail mode.  In 
Detail mode, the information displayed on the screen cannot be updated, and only the Details button and Close 
button are available. 

 
Journal Screen 

 
To access this screen:  Display the Financial Management [Journal] screen, and then do one of the 
following: 
• To view the details of a journal entry, select a journal entry in the Journal Entries table, display the 

Journal menu, and then click Details. 
• To edit a journal entry, select a journal entry that has not yet been posted in the Journal Entries 

table, display the Journal menu, and then click Edit. 
• To add a journal entry, display the Journal menu, and then click Add.  Or, click the Add Journal 

toolbar button (pictured below). 
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Screen Elements: 

Accounting Period – Select an accounting period for the journal entry in this list.  If a transaction exists for the 
journal entry, this list is not available. 

Journal Type – Select a type or classification for the journal entry in this list. 

Value Type – Select one of the following options from this group box: 

• Actual – Click this option to identify the journal entry as an actual entry. 

• Budget – Click this option to identify the journal entry as an budget entry. 

• Forecast – Click this option to identify the journal entry as an forecast entry. 

Journal Description – Enter a description of the journal entry. 

Journal Transactions – Click a transaction record in this table to select it.  This table displays transactions 
associated with the journal entry.  The following are associated with the table: 

• Add Trans – Click this button to add transactions to the journal. 

• Edit Trans – Click this button to edit a transaction selected in the table. 

• Delete Trans – Click this button to delete a transaction selected in the table. 

• Details – Click this button to view the details of a transaction selected in the table. 

Post – Click this button to process the screen and post the journal entry and its associated transactions. 

 
NOTE:  A posted journal entry can no longer be edited. 

Suspend – Click this button to process the screen and suspend the journal entry and its associated transactions. 

 
NOTE:  A suspended journal entry can later be edited. 

Import – Click this button to process the screen, and then import journal entries. 

Delete Entry – Click this button to delete the journal entry and its associated transactions. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Add or Edit mode. 

Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in 
Details mode. 

 

12 



W O R K I N G  W I T H  J O U R N A L S  

Add, Edit, and Details 
Journal Transaction 

The Journal Transaction screen is used to manage a journal transaction and can be displayed in Add, Edit, or 
Detail mode.  In Detail mode, the information displayed on the screen cannot be updated, and only the Close 
button is available. 

 
Journal Transaction Screen 

 
To access this screen:  Display the Journal screen, and then do one of the following: 
• To add a journal transaction, click Add Trans. 
• To edit a journal transaction, select a journal transaction in the Journal Transactions table, and 

then click Edit Trans. 
• To view the details of a journal transaction, select a journal transaction in the Journal Transactions 

table, and then click Details. 

Screen Elements: 

Transaction Date – Enter or select the date on which the journal transaction occurred. 

Fund – Select a fund for the journal transaction. 

Financial Account – Select the financial account for the journal transaction. 

Natural Account – Select the natural account for the journal transaction. 

Agency – Select the agency for the journal transaction. 

Debit – Enter the debit amount of the journal transaction. 

13 
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Credit – Enter the credit amount of the journal transaction. 

Transaction Description – Enter a description of the journal transaction. 

Post Period – Select this check box to identify the journal transaction as a post period transaction. 

Save – Click this button to process the screen and redisplay the screen to add additional journal transaction as 
necessary.  This button is only available when the screen is displayed in Add mode. 

OK – Click this button to process the screen.  This button is only available when the screen is displayed in Edit 
mode. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Edit mode. 

Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in Add 
and Details mode. 
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Import 
Import Journal Entry 

The Import Journal Entry screen is used to import journal entries. 

 
Import Journal Entry Screen 

 
To access this screen:   
• Display the Journal screen > Click Import. 

Screen Elements: 

Look in – Select the folder in which the file is located, and then select the file in the box located below the Look 
in list. 

Open – Click this button to import the selected file. 

Cancel – Click this button to dismiss the screen without processing it. 
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Financial Account Inquiry 
Financial Account Inquiry 

The Financial Account Inquiry screen is used to search for journal entries and view them in Standard Account 
form or Balance Column Account Sheet format. 

 
Financial Account Inquiry Screen 

 
To access this screen:   
• Display the Financial Management [Journal] screen > On the Journal menu, click Financial 

Account Inquiry. 

Screen Elements: 

Fund – Select a fund to search for journal entries associated with that fund. 

Financial Account – Select a financial account to search for journal entries associated with that financial 
account. 

Natural Account – Select a natural account to search for journal entries associated with that natural account. 

Agency – Select an agency in this list to search for journal entries associated with that agency. 

Accounting Period – Select an accounting period to search for journal entries from that accounting period. 
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Complete the following information to specify a date range in which to search for journal entries with a 
transaction date that falls within that range: 

• Transaction from – Enter or select the starting date of the date range. 

• through – Enter or select the ending date of the date range. 

Journal Type– Select a journal type to search for journal entries of that journal type. 

Value Type – Select a value type to search for journal entries of that value type. 

Post Period Items Only – Select this check box to include only post period journal entries in the search. 

Search – Click this button to apply the specified search criteria to the Journal Transactions table.  The content 
of the Journal Transactions table is refreshed to display journal transactions that match the specified search 
criteria. 

Journal Transactions – This table displays journal transactions as determined by the search criteria applied using 
the Search button. 

Close – Click this button to dismiss the screen. 
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Accounting Schedule List 
Accounting Schedule List 

The Accounting Schedule List screen is used to manage the list of accounting schedules. 

 
Accounting Schedule List Screen 

 
To access this screen:   
• Display the Financial Management [Journal] screen > On the Journal menu, click Accounting 

Schedule List. 

Screen Elements: 

Accounting Year – Select a year for which to display an accounting schedule. 

Add Accounting Schedule – Click this button to add an accounting schedule. 

Accounting Period – Click a listed accounting period in this table to select it.  This table displays the accounting 
schedule for the selected Accounting Year.  The following are associated with the table: 

• Edit – Click this button to edit an accounting period selected in the table. 

• Details – Click this button to view the details of an accounting period selected in the table. 

Close – Click this button to dismiss the screen. 
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Edit and Details 
Accounting Schedule 

The Accounting Schedule screen is used manage an accounting schedule and can be displayed in Edit or Detail 
mode.  In Detail mode, the information displayed on the screen cannot be updated, and only the Close button is 
available. 

 
Accounting Schedule Screen 

 
To access this screen:  Display the Accounting Schedule List screen, select an accounting schedule in the 
Accounting Period table, and then do one of the following: 
• To edit an accounting schedule, click Edit. 
• To view the details of an accounting schedule, click Details. 

Screen Elements: 

Open for Adjustment – Select this check box to set the accounting period to accept adjustments. 

OK – Click this button to process the screen.  This button is only available when the screen is displayed in Edit 
mode. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Edit mode. 

Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in 
Detail mode. 
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Add Accounting Schedule 
Add Accounting Year 

The Add Accounting Year screen is used to add an accounting schedule for a selected year. 

 
Add Accounting Year Screen 

 
To access this screen:   
• Display the Accounting Schedule List screen > Click Add Accounting Schedule. 

Screen Elements: 

Accounting Year – Enter or select an accounting year for which to add an accounting schedule. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Funds List 
Funds List 

The Funds List screen is used to manage a funds list. 

 
Funds List Screen 

 
To access this screen:   
• Display the Financial Management [Journal] screen > On the Journal menu, click Funds List. 

Screen Elements: 

Funds List – Click an fund listed in the table to select it.  This table displays a list of funds.  The following are 
associated with the table: 

• Add – Click this button to add a fund. 

• Edit – Click this button to edit a fund selected in the table. 

• Delete – Click this button to delete a fund selected in the table. 

• Details – Click this button to view a fund selected in the table. 

Close – Click this button to dismiss the screen. 
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Add, Edit, and Details 
Fund 

The Fund screen is used to manage a fund and can be displayed in Add, Edit, or Detail mode.  In Detail mode, 
the information displayed on the screen cannot be updated, and only the Close button is available. 

 
Fund Screen 

 
To access this screen:  Display the Funds List screen, and then do one of the following: 
• To add a fund, click Add. 
• To edit a fund, select a fund in the Funds List table, and click Edit. 
• To view the details of a fund, select a fund in the Funds List table, and then click Details. 

Screen Elements: 

Status – Select the fund's status. 

Fund Name – Enter the fund's name. 

Complete the following information to specify the primary contact person: 

• Contact Salutation – Enter the contact's title.  (For example, Mr., Mrs., Miss, Ms., Dr., and so on.) 

• First Name – Enter the contact's first name. 

• Last Name – Enter the contact's last name. 

• Address – Enter the street address at which the contact receives mail.  Additional street address 
information can be entered in the secondary Address box. 

• City – Enter the city in which the contact receives mail. 

• State – Select the state in which the contact receives mail. 

• ZIP – Enter the five- or nine-digit code for the postal zone in which the contact receives mail. 
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• Telephone – Enter the telephone number at which the contact can be contacted. 

Fund Type – Select the fund's type or classification. 

Program – Select the program with which the fund is associated. 

Class – Select the fund's class. 

Sub-class – Select the fund's sub-class. 

Fiscal Year Type – Select the fund's fiscal year type. 

Begin Fiscal Year – Select the month in which the fiscal year begins for funds based on the Fiscal Year Type 
selected. 

OK – Click this button to process the screen.  This button is only available when the screen is displayed in Add 
or Edit mode. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Add or Edit mode. 

Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in 
Details mode. 
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Financial Accounts List 
Financial Accounts List 

The Financial Accounts List screen is used to manage financial accounts. 

 
Financial Accounts List Screen 

 
To access this screen:   
• Display the Financial Management [Journal] screen > On the Journal menu, click Financial 

Accounts List. 

Screen Elements: 

Financial Accounts List – Click a financial account record in this table to select it.  This table displays a list of 
financial accounts.  The following are associated with the table: 

• Add – Click this button to add a financial account. 

• Edit – Click this button to edit a financial account selected in the table. 

• Delete – Click this button to delete a financial account selected in the table. 

• Details – Click this button to view the details of a financial account selected in the table. 

Close – Click this button to dismiss the screen. 
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Add, Edit, and Details 
Financial Account 

The Financial Account screen is used to manage a financial account and can be displayed in Add, Edit, or Detail 
mode.  In Detail mode, the information displayed on the screen cannot be updated, and only the Close button is 
available. 

 
Financial Account Screen 

 
To access this screen:  Display the Financial Accounts List screen, and then do one of the following: 
• To add a financial account, click Add. 
• To edit a financial account, select a financial account in the Financial Accounts List table, and then 

click Edit. 
• To view the details of a financial account, select a financial account in the Financial Accounts List 

table, and then click Details. 

Screen Elements: 

Financial Account Code – Enter a unique ID or code for the financial account. This box is only available in 
Add mode. 

Financial Account Name – Enter a name of the financial account. 

Select funds where this account may be used – Select the check box displayed in the Select column of this 
table for each fund to be associated with the financial account.  This table displays a list of available funds. 

OK – Click this button to process the screen.  This button is only available when the screen is displayed in Add 
or Edit mode. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Add or Edit mode. 
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Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in 
Details mode. 
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Natural Accounts List 
Natural Accounts List 

The Natural Accounts List screen is used to manage natural accounts. 

 
Natural Accounts List Screen 

 
To access this screen:   
• Display the Financial Management [Journal] screen > On the Journal menu, click Natural 

Accounts List. 

Screen Elements: 

Natural Accounts List – Click a natural account in this table to select it.  This table displays a list of natural 
accounts.  The following are associated with the table: 

• Add – Click this button to add a natural account. 

• Edit – Click this button to edit a natural account selected in the table. 

• Delete – Click this button to delete a natural account selected in the table. 

• Details – Click this button to view a natural account selected in the table. 

Close – Click this button to dismiss the screen. 
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Add, Edit, and Details 
Natural Account 

The Natural Account screen is used to manage a natural account and can be displayed in Add, Edit, or Detail 
mode.  In Detail mode, the information displayed on the screen cannot be updated, and only the Close button is 
available. 

 
Natural Account Screen 

 
To access this screen:  Display the Natural Accounts List screen, and then do one of the following: 
• To add a natural account, click Add. 
• To edit a natural account, select a natural account in the Natural Accounts List table, and then 

click Edit. 
• To view the details of a natural account, select a natural account in the Natural Accounts List table, 

and then click Details. 

Screen Elements: 

Natural Account Code – Enter a unique ID or code for the natural account.  This box is only available in Add 
mode. 

Natural Account Name – Enter a name for the natural account. 

Account Type – Select the type or classification of the natural account in this list. 

Normal Balance – Select one of the following options from this group box: 

• Debit – Click this option to identify the normal balance of the natural account as debit. 

• Credit – Click this option to identify the normal balance of the natural account as credit. 

Mandatory Account – Select this check box to identify the natural account as mandatory. 

Agency Required – Select this check box to require an agency selection when journals entries are added to the 
natural account. 

OK – Click this button to process the screen.  This button is only available when the screen is displayed in Add 
or Edit mode. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Add or Edit mode. 
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Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in 
Details mode. 
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Financial Statements List 
Financial Statements List 

The Financial Statements List screen is used to manage a financial statements list. 

 
Financial Statements List Screen 

 
To access this screen:   
• Display the Financial Management [Journal] screen > On the Journal menu, click Financial 

Statements List. 

Screen Elements: 

Financial Statements List – Click a financial statement record in this table to select it.  This table displays a list 
of financial statements.  The following are associated with the table: 

• Statement Line List – Click this button to work with the financial statement line list for a financial 
statement selected in the table. 

• Fund Variant List – Click this button to work with the fund variant list for a financial statement selected 
in the table. 

• Edit – Click this button to edit a financial statement selected in the table. 

• Details – Click this button to view the details of a financial statement selected in the table. 

Close – Click this button to dismiss the screen. 
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Edit and Details 
Financial Statement 

The Financial Statement screen is used to manage a financial statement and can be displayed in Edit or Detail 
mode.  In Detail mode, the information displayed on the screen cannot be updated, and only the Close button is 
available. 

 
Financial Statement Screen 

 
To access this screen:  Display the Financial Statements List screen, select a financial statement in the 
Financial Statements List table, and then do one of the following: 
• To edit a financial statement, click Edit. 
• To view the details of a financial statement, click Details. 

Screen Elements: 

Name – Enter the name of the financial statement. 

Template Path / File – Enter the path and file name of the template to use for the financial statement.  The 
following is associated with the box: 

• Template Path / File Browse – Click this button (pictured below) to browse for a template file if the 
exact location is unknown. 

 

Destination Path – Enter the path of the destination folder for the financial statement.  The following is 
associated with the box: 

• Destination Path Browse – Click this button (pictured below) to browse for a destination folder if is the 
exact location is unknown. 

 

OK – Click this button to process the screen.  This button is only available when the screen is displayed in Edit 
mode. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Edit mode. 

Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in 
Details mode. 
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Select Path 
The Select Path screen is used to browse for file and folder paths. 

 
Select Path Screen 

 
To access this screen:   
• Display the Financial Statement screen > Click the Browse button (pictured below) for either 

Template Path / File or Destination Path Browse. 

 

Screen Elements: 

Look in – Select the folder in which to browse, and then select the file or folder in the box located below the 
Look in list. 

Open – Click this button to save the path. 

Cancel – Click this button to dismiss the screen without processing it. 
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Statement Line List 
Financial Statement Line List 

The Financial Statement Line List screen is used to manage a financial statement line list. 

 
Financial Statement Line List Screen 

 
To access this screen:   
• Display the Financial Statements List screen > Select a financial statement in the Financial 

Statements List table > Click Statement Line List. 

Screen Elements: 

Statement Lines – Click a financial statement line record in this table to select it.  This table displays the list of 
lines in a financial statement.  The following are associated with the table: 

• Account List – Click this button to manage the financial account list associated with a financial statement 
line selected in the Statement Lines table. 

• Add – Click this button to add a line to the financial statement. 

• Edit – Click this button to edit a financial statement line selected in the Statement Lines table. 

• Delete – Click this button to delete a financial statement line selected in the Statement Lines table. 

• Details – Click this button to view the details of a financial statement line selected in the Statement Lines 
table. 

Close – Click this button to dismiss the screen. 
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Add, Edit, and Details 
Financial Statement Line 

The Financial Statement Line screen is used to manage a financial statement line. and can be displayed in Add, 
Edit, or Detail mode.  In Detail mode, the information displayed on the screen cannot be updated, and only the 
Close button is available. 

 
Financial Statement Line Screen 

 
To access this screen:  Display the Financial Statement Line List screen, and then do one of the 
following: 
• To add a financial statement line, click Add. 
• To edit a financial statement line, select a financial statement line in the Statement Lines table, and 

then click Edit. 
• To view the details of a financial statement line, select a financial statement line in the Statement 

Lines table, and then click Details. 

Screen Elements: 

Description – Enter a description of the financial statement line.  

OK – Click this button to process the screen.  This button is only available when the screen is displayed in Add 
or Edit mode. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Add or Edit mode. 

Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in 
Details mode. 
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Account List 
Financial Statement Line Account List 

The Financial Statement Line Account List screen is used to manage a financial statement line account list. 

 
Financial Statement Line Account List Screen 

 
To access this screen:   
• Display the Financial Statement Line List screen > Select a line in the Statement Lines table > 

Click Account List. 

Screen Elements: 

Accounts – Click an account record in this table to select it.  This table displays the list of financial accounts 
associated with the financial statement line and their associated natural accounts.  The following are associated 
with the table: 

• Add – Click this button to add a financial account and the natural accounts initially associated with it to the 
financial statement line. 

• Edit – Click this button to edit the natural accounts associated with a financial account selected in the 
Accounts table. 

• Delete – Click this button to delete a natural account selected in the Accounts table. 

• Details – Click this button to view the details of an account selected in the Accounts table. 

Close – Click this button to dismiss the screen. 
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NOTE:  When the last natural account associated with a financial account is deleted, the financial account 
is also deleted. 
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Add, Edit, and Details 

Financial Statement Line Account 
The Financial Statement Line Account screen is used to manage a financial statement line account and can be 
displayed in Add, Edit, or Detail mode.  In Detail mode, the information displayed on the screen cannot be 
updated, and only the Close button is available. 

 
Financial Statement Line Account Screen 

 
To access this screen:  Display the Financial Statement Line Account List screen, and then do one of 
the following: 
• To add a financial statement line account, click Add. 
• To edit a financial statement line account, select a financial account line in the Accounts table, and 

then click Edit. 
• To view the details of a financial statement line account, select a financial account in the Accounts 

table, and then click Details. 

Screen Elements: 

Financial Account – Select a financial account to associate with the financial statement line.  This list is only 
available when the screen is displayed in Add mode. 

Natural Account – Click the check box displayed in the Select column of this table for each natural account to 
be associated with the financial account.  This table displays a list of available natural accounts. 

OK – Click this button to process the screen.  This button is only available when the screen is displayed in Add 
or Edit mode. 
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Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Add or Edit mode. 

Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in 
Details mode. 
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Fund Variant List 
Financial Statement Fund Variant List 

The Financial Statement Fund Variant List screen is used to manage a fund variant list. 

 
Financial Statement Fund Variant List Screen 

 
To access this screen:   
• Display the Financial Statements List screen > Select a financial statement in the Financial 

Statements List table > Click Fund Variant List. 

Screen Elements: 

Show Variants for the Year – Select a calendar year for which to display a fund variant list. 

Add Year – Click this button to add a fund variant list. 

Statement Fund Variants – Click a period record in this table to select it.  This table displays the fund variant 
list for the selected calendar year.  The following are associated with the table: 

• Edit – Click this button to edit a fund variant for a period selected in the table. 

• Details – Click this button to view the details of a fund variant for a period selected in the table. 

Close – Click this button to dismiss the screen. 
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Add Year 
Add Financial Statement Variant Year 

The Add Financial Statement Variant Year screen is used to add a fund variant list for the selected year. 

 
Add Financial Statement Variant Year Screen 

 
To access this screen:   
• Display the Financial Statement Fund Variant List screen > Click Add Year. 

Screen Elements: 

Calendar Year – Enter or select a calendar year for which to add a fund variant list. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Edit and Details 
Financial Statement Fund Variant 

The Financial Statement Fund Variant screen is used to manage a period in a fund variant list and can be 
displayed in Edit or Detail mode.  In Detail mode, the information displayed on the screen cannot be updated, 
and only the Close button is available. 

 
Financial Statement Fund Variant Screen 

 
To access this screen:  Display the Financial Statement Fund Variant List screen, select a period in the 
Statement Fund Variants table, and then do one of the following: 
• To edit a fund variant list period, click Edit. 
• To view the details of a fund variant list period, click Details. 

Screen Elements: 

Redemption – Enter the redemption value for the period. 

Caseload – Enter the caseload value for the fund period. 

Inflation – Enter the Inflation value for the fund period. 

OK – Click this button to process the screen.  This button is only available when the screen is displayed in Edit 
mode. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Edit mode. 

Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in 
Details mode. 
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Activities 

Bank Exceptions 
Bank Exceptions 

The Bank Exceptions screen is used to manage bank exceptions. 

 
Bank Exceptions Screen 

 
To access this screen:   
• Display the Financial Management screen > On the Activities menu, click Bank Exceptions. 

Screen Elements: 

Month of – Select the month for which to display bank exceptions. 

Bank Exceptions – Click a bank exception listed in the table to select it.  This table displays bank exceptions for 
the month selected in the Month of list.  The following is associated with the table: 

• Edit – Click this button to edit a bank exception selected in the table. 

Close – Click this button to dismiss the screen. 
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Edit Bank Exception 
The Edit Bank Exception screen is used to edit bank exceptions. 

 
Edit Bank Exception Screen 

 
To access this screen:   
• Display the Bank Exceptions screen, select an exception in the Bank Exceptions table, and then 

click Edit. 

Screen Elements: 

Payment Amount – Enter the payment amount of the food instrument. 

Paid Date – Enter the date on which the payment was made on the food instrument. 

Stamp Number – Enter the stamp number on the food instrument. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
 

43 





 

Working with Rebate Suppliers 
The Financial Management [Rebate Suppliers] screen is used to manage rebate suppliers. 

 
Financial Management [Rebate Suppliers] Screen 

 
To access this screen:   
• On the View menu, click Rebate Suppliers. 

A Menu Bar and a Toolbar are displayed at the top of the screen.  The menu bar provides access to functions 
that are not available on the main screen.  Click a menu to display the list of available commands, and then click a 
command to activate its functionality.  The toolbar provides access to frequently used functions, usually with a 
single click.  Click a toolbar button to activate its functionality.  For more information about the menu bar, see 
the Financial Management [Rebate Supplier] Menu Bar topic, and for more information about the toolbar, 
see the Financial Management Toolbar topic. 

Screen Elements: 

Rebate Suppliers – Click a rebate supplier record in this table to select it.  This table displays a list of rebate 
suppliers. 

 
NOTE:  On the View menu, click Refresh View to refresh the list of rebate suppliers displayed in the 
table. 
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The Financial Management [Rebate Supplier] 
Menu Bar 

The Financial Management [Rebate Supplier] Menu Bar provides access to functions on the Journal view 
of the Financial Management screen.  Depending on your permission level and the client's current status, some 
commands on the menus may not be available for selection. 

Screen Elements: 

File – Click this menu to access commands that are common to the main screens within the application.  The 
following commands are displayed: 

• Filter Journal View – Click this command to filter the list of journals. 

• System Tools – Point to this sub-menu to display the following system tools: 

o Change Password – Click this command to change the password of the currently logged on user. 

o Set Default Printers – Click this command to specify the default printers for the currently logged 
on user. 

• Reports – Click this command to generate reports. 

• Exit – Click this command to exit the application. 

Rebate Suppliers – Click this menu to access rebate supplier commands for the Financial Management 
screen.  The following commands are displayed: 

• Add – Click this command to add a rebate supplier. 

• Edit – Click this command to edit a rebate supplier selected in the Rebate Suppliers table. 

• Delete – Click this command to delete a rebate supplier selected in the Rebate Suppliers table. 

• Details – Click this command to view a rebate supplier selected in the Rebate Suppliers table. 

• Rebate Supplier Account – Click this command to manage a rebate supplier account. 

View – Click this menu to access commands that change the view of the Financial Management screen.  The 
following commands are displayed: 

• Journal – Click this command to display the Journal view of the Financial Management screen. 

• Rebate Suppliers – Click this command to display the Rebate Supplier view of the Financial 
Management screen. 

• Refresh View – Click this command to refresh the view of the Financial Management screen. 

Activities – Click this menu to access financial management activities.  The following command is displayed: 

• Bank Exceptions – Click this command to manage bank exceptions. 

Help – Click this menu to access user assistance information.  The following commands are displayed: 

• Help on Screen – Click this command to display the topic for the Financial Management screen. 

• Financial Management Help Topics – Click this command to display the help overview. 

• About – Click this command to display information about the application itself. 
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The Financial Management Toolbar 
The Financial Management Toolbar provides access to frequently used functions on the Journal view of the 
Financial Management screen.  Depending on your permission level and the client's current status, some 
toolbar buttons may not be available for selection. 

 
The Financial Management Toolbar 

Screen Elements: 

 
Filter Journal View – Click this toolbar button to filter the list of journals.  This toolbar button is only 
available in Journal view. 

 
Reports – Click the this toolbar button to generate reports. 

 
System Tools – Click the down-arrow on this toolbar button, and then click an option on the menu: 
• Change Password – Click this command to change the password of the currently logged on user. 
• Set Default Printers – Click this command to specify the default printers for the currently logged 

on user. 

 
Exit Application – Click this toolbar button to exit the application. 

 
Add Journal – Click this toolbar button to add a journal.  This toolbar button is only available in Journal 
view. 
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Rebate Suppliers menu 

Add, Edit, and Details 
Rebate Supplier 

The Rebate Supplier screen is used to manage a rebate supplier's information and can be displayed in Add, Edit, 
or Detail mode.  It is designed to mimic a hanging file folder and displays client information on tabbed pages 
labeled according to their content.  In Detail mode, the information displayed on the screen cannot be updated, 
and only the Close button is available. 

 
Rebate Supplier Screen 

 
To access this screen:  Display the Financial Management [Rebate Suppliers] screen, and then do one 
of the following: 
• To add a rebate supplier, display the Rebate Suppliers menu, and then click Add. 
• To edit a rebate supplier, select a rebate supplier in the Rebate Suppliers table, display the Rebate 

Suppliers menu, and then click Edit. 
• To view the details of a rebate supplier, select a rebate supplier in the Rebate Suppliers table, 

display the Rebate Suppliers menu, and then click Details. 

Screen Elements: 

The following tabbed pages are displayed: 
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• Contact 

• Products 

• Agreements 

OK – Click this button to process the screen.  This button is only available when the screen is displayed in Add 
or Edit mode. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Add or Edit mode. 

Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in 
Details mode. 
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Contact tab 
The Contact screen is used to manage contact information for the current rebate supplier.  It is a tabbed page on 
the Rebate Supplier screen, which can be displayed in Add, Edit, or Detail mode.  In Detail mode, the 
information displayed on the screen cannot be updated, and only the Close button is available. 

 
Contact Screen 

 
To access this screen:   
• Display the Rebate Supplier screen > Click the Contact tab as necessary (this screen is displayed 

by default). 

Screen Elements: 

Supplier Name – Enter the name of the rebate supplier. 

Billing Address – Enter the street address at which the rebate supplier receives bills.  Additional street address 
information can be entered in the secondary box. 

City – Enter the city in which the rebate supplier receives bills. 

State – Select the state in which the rebate supplier receives bills. 

ZIP – Enter the five- or nine-digit code for the postal zone in which the rebate supplier receives bills. 

Complete the following information in this group box to specify the primary contact person: 

• Contact Salutation – Enter the contact's courtesy title.  (For example, Mr., Mrs., Miss, Ms., Dr., and so 
on.) 
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• Contact First Name – Enter the contact's first name. 

• Contact Last Name – Enter the contact's last name. 

Email Address – Enter the contact's email address. 

Telephone – Enter the telephone number at which the contact can be contacted. 

Fax Number – Enter the telephone number at which the contact receives facsimiles. 

Status – Select a status for the rebate supplier. 

Federal ID Number – Enter the rebate supplier's federal identification number. 

Remarks – Enter any comments about the rebate supplier. 

OK – Click this button to process the Rebate Supplier screen.  This button is only available when the screen is 
displayed in Add or Edit mode. 

Cancel – Click this button to dismiss the Rebate Supplier screen without processing it.  This button is only 
available when the screen is displayed in Add or Edit mode. 

Close – Click this button to dismiss the Rebate Supplier screen.  This button is only available when the screen is 
displayed in Details mode. 
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Products tab 
The Products screen is used to manage the list of products stocked by the current rebate supplier that qualify for 
rebates.  It is a tabbed page on the Rebate Supplier screen, which can be displayed in add, edit or detail mode. 
 In Detail mode, the information displayed on the screen cannot be updated, and only the Details button and 
Close button are available. 

 
Products Screen 

 
To access this screen:   
• Display the Rebate Supplier screen > Click the Products tab. 

Screen Elements: 

Products – Click a product in this table to select it.  This table displays a list of products.  The following are 
associated with the table: 

• Add – Click this button to add a product. 

• Edit – Click this button to edit a product selected in the table. 

• Delete – Click this button to delete a product selected in the table. 

• Details – Click this button to view a product selected in the table. 

OK – Click this button to process the Rebate Supplier screen.  This button is only available when the screen is 
displayed in Add or Edit mode. 

Cancel – Click this button to dismiss the Rebate Supplier screen without processing it.  This button is only 
available when the screen is displayed in Add or Edit mode. 
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Close – Click this button to dismiss the Rebate Supplier screen.  This button is only available when the screen is 
displayed in Details mode. 
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Add, Edit, and Details 
The Product screen is used to manage a product and can be displayed in Add, Edit, or Detail mode.  In Detail 
mode, the information displayed on the screen cannot be updated, and only the Close button is available. 

 
Product Screen 

 
To access this screen:  Display the Products screen, and then do one of the following: 
• To add a product, click Add. 
• To edit a product, select a product in the Products table, and then click Edit. 
• To view the details of a product, select a product in the Products table, and then click Details. 

Screen Elements: 

Commodity – Select the commodity of the product in this list. 

Product Name – Enter the name of the product. 

Unit of Measure – Select the unit by which the product is measured in this list. 

UPC – Enter the product's universal product code. 

OK – Click this button to process the screen.  This button is only available when the screen is displayed in Add 
or Edit mode. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Add or Edit mode. 

Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in 
Details mode. 
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Agreements tab 
The Agreements screen is used to manage the list of rebate agreements for the current rebate supplier.  It is a 
tabbed page on the Rebate Supplier screen, which can be displayed in Add, Edit, or Detail mode.  In Detail 
mode, the information displayed on the screen cannot be updated, and only the Details button and Close button 
are available. 

 
Agreements Screen 

 
To access this screen:   
• Display the Rebate Supplier screen > Click the Agreements tab. 

Screen Elements: 

Agreements – Click an agreement record in this table to select it.  This table displays a list of agreements.  The 
following are associated with the table: 

• Add – Click this button to add an agreement. 

• Edit – Click this button to edit an agreement selected in the table. 

• Delete – Click this button to delete an agreement selected in the table. 

• Details – Click this button to view the details of an agreement selected in the table. 

OK – Click this button to process the Rebate Supplier screen.  This button is only available when the screen is 
displayed in Add or Edit mode. 

Cancel – Click this button to dismiss the Rebate Supplier screen without processing it.  This button is only 
available when the screen is displayed in Add or Edit mode. 
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Close – Click this button to dismiss the Rebate Supplier screen.  This button is only available when the screen is 
displayed in Details mode. 
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Add, Edit, and Details 
The Rebate Agreement screen is used to manage a rebate agreement and can be displayed in Add, Edit, or 
Detail mode.  It is designed to mimic a hanging file folder and displays client information on tabbed pages labeled 
according to their content.  In Detail mode, the information displayed on the screen cannot be updated, and only 
the Close button is available. 

 
Rebate Agreement Screen 

 
To access this screen:  Display the Agreements screen, and then do one of the following: 
• To a rebate agreement, click Add. 
• To edit a rebate agreement, select an agreement in the Agreements table, and then click Edit. 
• To view the details of a rebate agreement, select an agreement in the Agreements table, and then 

click Details. 

Screen Elements: 

The following tabbed pages are displayed: 

• Agreement 

• Rebate Items 

OK – Click this button to process the screen.  This button is only available when the screen is displayed in Add 
or Edit mode. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Add or Edit mode. 
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Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in 
Details mode. 
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Agreement tab 
The Agreement screen is used to manage agreement information for the current rebate agreement.  It is a tabbed 
page on the Rebate Agreement screen and can be displayed in Add, Edit, or Detail mode.  In Detail mode, the 
information displayed on the screen cannot be updated, and only the Close button is available. 

 
Agreement Screen 

 
To access this screen:   
• Display the Rebate Agreement screen > Click the Agreement tab as necessary (this screen displays 

by default). 

Screen Elements: 

Commodity – Select a commodity upon which the agreement is based. 

Agreement Title – Enter the title for the agreement. 

Effective – Enter or select the date on which the agreement becomes effective. 

through – Enter or select the date on which the agreement expires. 

Billing Address – Enter the street address to which bills are sent for the agreement.  Additional street address 
information can be entered in the secondary box. 

City – Enter the city to which bills are sent for the agreement. 

State – Select the state to which bills are sent for the agreement. 

ZIP – Enter the five- or nine-digit code for the postal zone to which bills are to be sent for the agreement. 
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Contact Salutation – Enter the contact's title.  (For example, Mr., Mrs., Miss, Ms., Dr., and so on.) 

Contact First Name – Enter the contact's first name. 

Contact Last Name – Enter the contact's last name. 

Telephone – Enter the contact's telephone number. 

Fax Number – Enter the contact's fax number. 

Allow Mid–term Rebate Adjustments – Select this check box to set the agreement to allow mid–term rebate 
adjustments. 

OK – Click this button to processes the Rebate Agreement screen.  This button is only available when the 
screen is displayed in Add or Edit mode. 

Cancel – Click this button to dismiss the Rebate Agreement screen without processing it.  This button is only 
available when the screen is displayed in Add or Edit mode. 

Close – Click this button to dismiss the Rebate Agreement screen.  This button is only available when the 
screen is displayed in Details mode. 
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Rebate Items tab 
The Rebate Items screen is used to manage rebate schedules associated with a rebate agreement.  It is a tabbed 
page on the Rebate Agreement screen, which can be displayed in Add, Edit, or Detail mode.  In Detail mode, 
the information displayed on the screen cannot be updated, and only the Close button is available. 

 
Rebate Items Screen 

 
To access this screen:   
• Display the Rebate Agreement screen > Click the Rebate Items tab. 

Screen Elements: 

Rebate Billed as of – Enter or select a date for which to display a rebate schedule. 

Add Rebate Schedule – Click this button to add a rebate schedule.  This button is only available if the rebate 
agreement allows mid–term adjustments and then only if a rebate product has been selected for the current rebate 
schedule. 

Rebate Items – Click the plus sign  next to a product listed in this tree list to display the associated WIC food 
distribution items.  Click a product or one of its associated WIC food distribution items in this table to select a 
product.  This tree list displays rebate products that have been selected for the current rebate schedule.  The 
following are associated with this tree list: 

• Select Rebate Products – Click this button to select rebate products for the rebate schedule displayed in 
the tree list. 

• Edit – Click this button to edit a rebate product selected in the tree list. 

61 



F I N A N C I A L  M A N A G E M E N T  T R A I N I N G  M A N U A L  

OK – Click this button to processes the Rebate Agreement screen.  This button is only available when the 
screen is displayed in Add or Edit mode. 

Cancel – Click this button to dismiss the Rebate Agreement screen without processing it.  This button is only 
available when the screen is displayed in Add or Edit mode. 

Close – Click this button to dismiss the Rebate Agreement screen.  This button is only available when the 
screen is displayed in Details mode. 
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Add Rebate Schedule 
The Add Rebate Schedule screen is used to add a rebate schedule for the selected year. 

 
Add Rebate Schedule Screen 

 
To access this screen:   
• Display the Rebate Items screen > Click Add Rebate Schedule. 

Screen Elements: 

Rebate Schedule Effective Date – Enter or select a date for which to add a rebate schedule. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Select Rebate Products 
The Select Rebate Products screen is used to select rebate products for the current rebate schedule. 

 
Select Rebate Products Screen 

 
To access this screen:   
• Display the Rebate Items screen > Click Select Rebate Products. 

Screen Elements: 

Select Rebate Products – Click a product in this table to select it.  This table displays all products defined for 
the current rebate agreement. 

Select – Click this button to include a product selected in the table in the current rebate agreement and define the 
food distribution items associated with the product. 

Deselect – Click this button to exclude a product selected in the table from the current rebate agreement. 

Close – Click this button to dismiss the screen. 
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Rebate Item 
The Rebate Item screen is used to manage a rebate agreement item. 

 
Rebate Item Screen 

 
To access this screen:   
• Display the Select Rebate Products screen > Click Select. 

Screen Elements: 

Rebate Per Unit Amount – Enter rebate amount per unit for the rebate item. 

Food Distribution Item Inventory – Select a food item in this list and click the Select button (pictured below) 
to move the food item to the Items Related to Selected Rebate Product list. 

 

Items Related to Selected Rebate Product – Select a food item in this list and click the Remove button 
(pictured below) to move the food item to the Food Distribution Item Inventory list. 

 

OK – Click this button to processes the screen.  This button is only available when the screen is displayed in Add 
or Edit mode. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Add or Edit mode. 
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Rebate Supplier Account 
The Rebate Supplier Account screen is used to manage a rebate supplier account. 

 
Rebate Supplier Account Screen 

 
To access this screen:   
• Display the Financial Management [Rebate Suppliers] screen > Select a rebate supplier in the 

Rebate Suppliers table > On the Rebate Suppliers menu, click Rebate Supplier Account. 

Screen Elements: 

Account Transaction – Click an account transaction in this table to select it.  This table displays a list of account 
transactions for the current rebate supplier. 

Add – Click this button to add an account transaction. 

Edit – Click this button to edit an account transaction selected in the table. 

Delete – Click this button to delete an account transaction selected in the table. 

Details – Click this button to view an account transaction selected in the table. 

Show Invoice Items – Click this button to show the invoice items for a invoice selected in the table. 

Generate Invoice – Click this button to generate a rebate invoice. 

66 



W O R K I N G  W I T H  R E B A T E  S U P P L I E R S  

Reprint Invoice – Click this button to reprint a rebate invoice. 

Close – Click this button to dismiss the screen. 
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Add, Edit, and Details 
The Account Transaction screen is used to manage an account transaction and can be displayed in Add, Edit, or 
Detail mode.  In Detail mode, the information displayed on the screen cannot be updated, and only the Close 
button is available. 

 
Account Transaction Screen 

 
To access this screen:  Display the Rebate Supplier Account screen, and then do one of the following: 
• To add an account transaction, click Add. 
• To edit an account transaction, select an account transaction in the Account Transaction table, and 

then click Edit. 
• To view the details of an account transaction, select an account transaction in the Account 

Transaction table, and then click Details. 

Screen Elements: 

Date – Enter or select the date on which the account transaction occurred. 

Type – Select the type of the account transaction. 

Invoice ID – Enter the invoice identification number of the account transaction. 

Amount – Enter the amount of the account transaction. 

Reference – Enter the supplier check number for the account transaction. 

Remarks – Enter any remarks or comments for the account transaction. 

OK – Click this button to process the screen.  This button is only available when the screen is displayed in Add 
or Edit mode. 

Cancel – Click this button to dismiss the screen without processing it.  This button is only available when the 
screen is displayed in Add or Edit mode. 

Close – Click this button to dismiss the screen.  This button is only available when the screen is displayed in 
Details mode. 
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View Invoice Item Details 
Invoice Item Detail 

The Invoice Item Detail screen is used to view a list of products included on an invoice for a specific 
transaction. 

 
Invoice Item Detail Screen 

 
To access this screen:  Display the Rebate Supplier Account screen > Select a transaction in the 
Account Transaction table > Click Show Invoice Items. 

Screen Elements: 

Close – Click this button to dismiss the screen. 
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Generate Invoice 
The Print Rebate Invoice screen is used to generate a rebate invoice. 

 
Print Rebate Invoice Screen 

 
To access this screen:   
• Display the Rebate Supplier Account screen > Click Generate Invoice. 

Screen Elements: 

Accounting Period – Select an accounting period for which to generate an invoice. 

Number of Breastfed Infants – Enter the number of breastfed infants to print on the invoice cover letter. 

Number of Non–breastfed Infants – Enter the number of non–breastfed infants to print on the invoice cover 
letter. 

Express Mail Reference – Select this check box to calculate billing adjustments and generate an adjusted 
invoice. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Reprint Invoice 
The Reprint Rebate Invoice screen is used to reprint a rebate invoice. 

 
Reprint Rebate Invoice Screen 

 
To access this screen:   
• Display the Rebate Supplier Account screen > Click Reprint Invoice. 

Screen Elements: 

Invoice – Enter the invoice identification number to verify the invoice to be reprinted. 

Number of Breastfed Infants – Enter the number of breastfed infants to print of the invoice cover letter. 

Number of Non–breastfed Infants – Enter the number of non–breastfed infants to print of the invoice cover 
letter. 

Express Mail Reference – Enter the express mail reference to print on the invoice cover letter. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Activities 

Bank Exceptions 
Bank Exceptions 

The Bank Exceptions screen is used to manage bank exceptions. 

 
Bank Exceptions Screen 

 
To access this screen:   
• Display the Financial Management screen > On the Activities menu, click Bank Exceptions. 

Screen Elements: 

Month of – Select the month for which to display bank exceptions. 

Bank Exceptions – Click a bank exception listed in the table to select it.  This table displays bank exceptions for 
the month selected in the Month of list.  The following is associated with the table: 

• Edit – Click this button to edit a bank exception selected in the table. 

Close – Click this button to dismiss the screen. 
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Edit Bank Exception 
The Edit Bank Exception screen is used to edit bank exceptions. 

 
Edit Bank Exception Screen 

 
To access this screen:   
• Display the Bank Exceptions screen, select an exception in the Bank Exceptions table, and then 

click Edit. 

Screen Elements: 

Payment Amount – Enter the payment amount of the food instrument. 

Paid Date – Enter the date on which the payment was made on the food instrument. 

Stamp Number – Enter the stamp number on the food instrument. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Working with System Tools 

Set Password 
The Set Password screen is used to update the password for the signed-on user. 

 
Set Password Screen 

 
To access this screen:  Display the Financial Management screen, and then do one of the following: 
• On the File menu, point to System Tools, and then click Set Password. 
• Click the down-arrow on the System Tools toolbar button (pictured below), and then click Set 

Password. 

 

Screen Elements: 

Current Password – Enter the current password. 

New Password – Enter the new password. 

Confirm New Password – Enter the new password again for verification purposes. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Default Printers 
The Default Printers screen is used to specify the default printers for the signed-on user. 

 
Default Printers Screen 

 
To access this screen:  Display the Financial Management screen, and then do one of the following: 
• On the File menu, point to System Tools, and then click Default Printers. 
• Click the down-arrow on the System Tools toolbar button (pictured below), and then click Default 

Printers. 

 

Screen Elements: 

Checks – Select a Printer to be used for printing food instrument checks in the first list, and then select a Paper 
Source for that printer in the second list. 

Documents – Select a Printer to be used for printing general documents in the first list, and then select a Paper 
Source for that printer in the second list. 

Reports – Select a Printer to be used for printing reports in the first list, and then select a Paper Source for that 
printer in the second list. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generating Reports 
The Generate Reports screen is used to display a list of available reports and select a report for generation. 

 
Generate Reports Screen 

 
To access this screen:  Display the Financial Management screen, and then do one of the following: 
• On the File menu, point to System Outputs, and then click Generate Reports. 
• Click the down-arrow on the System Outputs toolbar button (pictured below), and then click 

Generate Reports. 

 

Screen Elements: 

Reports – Double-click a report type record in this table to generate it.  This table displays a list of available 
reports. 

 
NOTE:  An additional screen displays for the type of report selected.  Complete the screen to complete 
the process and generate the report. 

Close – Click this button to dismiss the screen. 
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Reports 

Generate Average Cost per Food Instrument Type 
Report 

The Generate Average Cost per Food Instrument Type Report screen is used to generate an Average Cost 
per Food Instrument Type report. 

 
Generate Average Cost per Food Instrument Type Report Screen 

 
To access this screen:   
• Display the Generate Reports screen > Double-click Average Cost per Food Instrument Type. 

Screen Elements: 

Month of – Select a month for which to generate the report. 

Report by – Select one of the following options from this group box to specify the report(s) to generate: 

• Clinic – Click this option to generate a report for a specific clinic. 

• Agency – Click this option to generate a report for a specific agency. 

• State – Click this option to generate a report for the state. 

• All – Click this option to generate reports for each clinic, each agency, and the state. 

Agency – Select an agency for which to generate the report if Clinic or Agency is selected under Report by. 

Clinic – Select a clinic for which to generate the report if Clinic is selected under Report By. 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 
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• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate Financial Accounts List Report 
The Generate Financial Accounts List Report screen is used to generate a Financial Accounts List report. 

 
Generate Financial Accounts List Report Screen 

 
To access this screen:   
• Display the Generate Reports screen > Double-click Financial Accounts List. 

Screen Elements: 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 

• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate FNS798 Statement Spreadsheet 
The Generate FNS798 Statement Spreadsheet screen is used to generate an FNS–798 Statement spreadsheet. 

 
Generate FNS798 Statement Spreadsheet Screen 

 
To access this screen:   
• Display the Rebate Supplier Account screen > Click FNS–798 Statement. 

Screen Elements: 

Federal Fiscal Year – Select a federal fiscal year for which to generate the spreadsheet. 

Through Accounting Period – Select an accounting period for which to generate the spreadsheet. 

Name and Title of Certifying Officer – Enter the name and title of the preparer. 

Telephone – Enter the  telephone number at which the preparer can be contacted. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate Food Instrument Reconciliation Exceptions 
Summary Report 

The Generate Food Instrument Reconciliation Exceptions Summary Report screen is used to generate a 
Food Instrument Reconciliation Exceptions Summary report. 

 
Generate Food Instrument Reconciliation Exceptions Summary Report Screen 

 
To access this screen:   
• Display the Generate Reports screen > Double-click Food Instrument Reconciliation 

Exceptions Summary. 

Screen Elements: 

Month of – Select a month for which to generate the report. 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 

• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate Food Instrument Reconciliation Summary 
Report 

The Generate Food Instrument Reconciliation Summary Report screen is used to generate a Food 
Instrument Reconciliation Summary report. 

 
Generate Food Instrument Reconciliation Summary Report Screen 

 
To access this screen:   
• Display the Generate Reports screen > Double-click Food Instrument Reconciliation 

Summary. 

Screen Elements: 

Month of – Select a month for which to generate the report. 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 

• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate Food Instrument Redemption Summary 
Report 

The Generate Food Instrument Redemption Summary Report screen is used to generate a Food Instrument 
Redemption Summary report. 

 
Generate Food Instrument Redemption Summary Report Screen 

 
To access this screen:   
• Display the Generate Reports screen > Double-click Food Instrument Redemption Summary. 

Screen Elements: 

Month of – Select a month for which to generate the report. 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 

• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate Food Instruments Redeemed Early Report 
The Generate Food Instruments Redeemed Early Report screen is used to generate a Food Instruments 
Redeemed Early report. 

 
Generate Food Instruments Redeemed Early Report Screen 

 
To access this screen:   
• Display the Generate Reports screen > Double-click Food Instruments Redeemed Early. 

Screen Elements: 

Month of – Select a month for which to generate the report. 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 

• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate Food Instruments Redeemed Late Report 
The Generate Food Instruments Redeemed Late Report screen is used to generate a Food Instruments 
Redeemed Late report. 

 
Generate Food Instruments Redeemed Late Report Screen 

 
To access this screen:   
• Display the Generate Reports screen > Double-click Food Instruments Redeemed Late. 

Screen Elements: 

Month of – Select a month for which to generate the report. 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 

• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate Food Instruments Rejected for Payment 
Report 

The Generate Food Instruments Rejected for Payment Report screen is used to generate a Food Instruments 
Rejected for Payment report. 

 
Generate Food Instruments Rejected for Payment Report Screen 

 
To access this screen:   
• Display the Generate Reports screen > Double-click Food Instruments Rejected for Payment. 

Screen Elements: 

Month of – Select a month for which to generate the report. 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 

• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate Food Obligations and Expenditures Report 
The Generate Food Obligations and Expenditures Report screen is used to generate a Food Obligations and 
Expenditures report. 

 
Generate Food Obligations and Expenditures Report Screen 

 
To access this screen:   
• Display the Generate Reports screen > Double-click Food Obligations and Expenditures. 

Screen Elements: 

Month of – Select a month for which to generate the report. 

Report by – Select one of the following options from this group box to specify the report(s) to generate: 

• Clinic – Click this option to generate a report for a specific clinic. 

• Agency – Click this option to generate a report for a specific agency. 

• State – Click this option to generate a report for the state. 

• All – Click this option to generate reports for each clinic, each agency, and the state. 

Agency – Select an agency for which to generate the report if Clinic or Agency is selected under Report by. 

Clinic – Select a clinic for which to generate the report if Clinic is selected under Report By. 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 

• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate Fund Budget Spreadsheet 
The Generate Fund Budget Spreadsheet screen is used to generate a Fund Budget spreadsheet. 

 
Generate Fund Budget Spreadsheet Screen 

 
To access this screen:   
• Display the Rebate Supplier Account screen > Click Fund Budget. 

Screen Elements: 

Fund – Select a fund for which to generate the spreadsheet. 

Accounting Period – Select an accounting period for which to generate the spreadsheet. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate Fund Management Summary Report 
The Generate Fund Management Summary Report screen is used to generate a Fund Management Summary 
report. 

 
Generate Fund Management Summary Report Screen 

 
To access this screen:   
• Display the Rebate Supplier Account screen > Click Fund Management Summary. 

Screen Elements: 

Federal Fiscal Year – Select a federal fiscal year for which to generate the spreadsheet. 

Natural Account – Select a natural account for which to generate the report. 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 

• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate Natural Accounts List Report 
The Generate Natural Accounts List Report screen is used to generate a Natural Accounts List report. 

 
Generate Natural Accounts List Report Screen 

 
To access this screen:   
• Display the Generate Reports screen > Double-click Natural Accounts List. 

Screen Elements: 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 

• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate Obligation Value for Outstanding Food 
Instruments Issued Report 

The Generate Obligation Value for Outstanding Food Instruments Issued Report screen is used to 
generate an Obligation Value for Outstanding Food Instruments Issued report. 

 
Generate Obligation Value for Outstanding Food Instruments Issued Report Screen 

 
To access this screen:   
• Display the Generate Reports screen > Double-click Obligation Value for OS FIs Issued. 

Screen Elements: 

Month of – Select a month for which to generate the report. 

Report by – Select one of the following options from this group box to specify the report(s) to generate: 

• Clinic – Click this option to generate a report for a specific clinic. 

• Agency – Click this option to generate a report for a specific agency. 

• State – Click this option to generate a report for the state. 

• All – Click this option to generate reports for each clinic, each agency, and the state. 

Agency – Select an agency for which to generate the report if Clinic or Agency is selected under Report by. 

Clinic – Select a clinic for which to generate the report if Clinic is selected under Report By. 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 

• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 
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Cancel – Click this button to dismiss the screen without processing it. 
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Generate Rebate Projection Worksheet Report 
The Generate Rebate Projection Worksheet Report screen is used to generate a Rebate Projection Worksheet 
report. 

 
Generate Rebate Projection Worksheet Report Screen 

 
To access this screen:   
• Display the Rebate Supplier Account screen > Click Rebate Projection Worksheet. 

Screen Elements: 

Month of – Select a month for which to generate the report. 

Commodity – Select a commodity for which to generate the report. 

Supplier – Select a supplier for which to generate the report. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate Supplier Rebate Report 
The Generate Supplier Rebate Report screen is used to generate a Supplier Rebate report. 

 
Generate Supplier Rebate Report Screen 

 
To access this screen:   
• Display the Generate Reports screen > Double-click Supplier Rebate. 

Screen Elements: 

Month of – Select a month for which to generate the report. 

Supplier – Select a supplier for which to generate the report. 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 

• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Generate WIC Closeout Summary Report 
The Generate WIC Closeout Summary Report screen is used to generate a WIC Closeout Summary report. 

 
Generate WIC Closeout Summary Report Screen 

 
To access this screen:   
• Display the Generate Reports screen > Double-click WIC Closeout Summary. 

Screen Elements: 

Month of – Select a month for which to generate the report. 

Report Destination – Select one of the following options from this group box to specify the destination of the 
generated report: 

• Display on Screen – Click this option to display the report on the computer's monitor after it is 
generated. 

• Send to Printer – Click this option to send the report to the selected Other Output Printer after it is 
generated. 

• Save as PDF – Click this option to save the report as a PDF file after it is generated. 

OK – Click this button to process the screen. 

Cancel – Click this button to dismiss the screen without processing it. 
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Training Scenarios 

Managing Accounting Years 

Adding an Accounting Year 
In this scenario, you will add an accounting year and generate an accounting schedule for the Financial 
Management module. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add an Accounting Year: 

3. Display the Financial Management [Journal] screen. 

4. On the Journal menu, click Accounting Schedule List.  The Accounting Schedule List screen displays. 

 
NOTE:  To simply view accounting periods within an accounting schedule, select an Accounting Year. 
 The Accounting Schedule List table displays the accounting schedule for the year you selected.  To view 
details about a period within the accounting schedule, select a period within the table and click the Details 
button. 

5. Click Add Accounting Schedule.  The Add Accounting Year screen displays. 

6. Enter the Accounting Year. 

7. Click OK.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully added a New Accounting Year. 
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Opening (or Closing) an Accounting Period for 
Adjustments 

In this scenario, you will learn how to open and close an accounting period for adjustments.  Open accounting 
periods are open to changes allowing updates.  Whereas closed accounting periods are closed to changes 
preventing updates. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Open (or Close) an Accounting Period for Adjustments: 

8. Display the Financial Management [Journal] screen. 

9. On the Journal menu, click Accounting Schedule List.  The Accounting Schedule List screen displays. 

10. Select an Accounting Year. 

11. Select a period in the Accounting Schedule List table. 

12. Click Edit.  The Accounting Schedule screen displays in edit mode. 

13. Select the Open for Adjustment check box. 

 
NOTE:  Clear the Open for Adjustment check box to close the accounting period and prevent 
adjustments. 

14. Click OK.  The Accounting Schedule List screen displays. 

15. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully opened (or closed) an accounting period for adjustments. 
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Managing Funds 

Adding a Fund 
In this scenario, you will add a fund to the Financial Management module. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add a Fund: 

16. Display the Financial Management [Journal] screen. 

17. On the Journal menu, click Funds List.  The Funds List screen displays. 

 
NOTE:  To simply view funds or details about a fund within the table, select a fund within the table and 
click the Details button.  Click Close when you are finished. 

18. Click Add.  The Fund screen displays in add mode. 

19. Complete the information on the Fund screen. 

20. Click OK.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully added a fund. 
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Editing a Fund 
In this scenario, you will edit or update a financial fund. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit a Fund: 

21. Display the Financial Management [Journal] screen. 

22. On the Journal menu, click Funds List.  The Funds List screen displays. 

23. Select a fund to edit in the Funds List table. 

24. Click Edit.  The Fund screen displays in edit mode. 

25. Update information on the Funds List screen as necessary. 

26. Click OK.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully edited or updated a fund. 
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Deleting a Fund 
In this scenario, you will delete a financial fund. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Delete a Fund: 

27. Display the Financial Management [Journal] screen. 

28. On the Journal menu, click Funds List.  The Funds List screen displays. 

29. Select a fund to delete in the Funds List table. 

30. Click Delete.  A confirmation message displays. 

31. Click Yes to confirm the deletion of the fund.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully deleted a fund. 
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Managing Financial Accounts 

Adding a Financial Account 
In this scenario, you will add a financial account. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add a Financial Account: 

32. Display the Financial Management [Journal] screen. 

33. On the Journal menu, click Financial Accounts List.  The Financial Accounts List screen displays. 

 
NOTE:  To simply view a financial account and its details, select an account from the Financial Account 
List table and click the Details button. 

34. Click Add.  The Financial Account screen displays in add mode. 

35. Enter a unique ID in the Financial Account Code. 

36. Enter the Financial Account Name. 

37. Select Funds listed in the table to associate funds to the new financial account. 

38. Click OK.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully added a New Financial Account. 
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Editing a Financial Account 
In this scenario, you will edit or update a financial account. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit a Financial Account: 

39. Display the Financial Management [Journal] screen. 

40. On the Journal menu, click Financial Accounts List.  The Financial Accounts List screen displays. 

 
NOTE:  To simply view a financial account and its details, select an account from the Financial Account 
List table and click the Details button. 

41. Select a financial account in the Financial Account List table. 

42. Click Edit.  The Financial Account screen displays in edit mode. 

43. Enter a unique ID in the Financial Account Code. 

44. Enter or update the Financial Account Name as necessary. 

45. Select or clear the check boxes in the Edit Financial Account table as necessary. 

 
NOTE:  Selecting a check box associates a fund with the financial account.  Clearing a check box removes 
the association. 

46. Click OK.  The Financial Accounts List screen displays. 

47. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully edited or updated a financial account. 
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Deleting a Financial Account 
In this scenario, you will delete a financial account. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Delete a Financial Account: 

48. Display the Financial Management [Journal] screen. 

49. On the Journal menu, click Financial Accounts List.  The Financial Accounts List screen displays. 

 
NOTE:  To simply view a financial account and its details, select an account from the Financial Account 
List table and click the Details button. 

50. Select an account in the Financial Account List screen. 

51. Click Delete.  A confirmation message displays. 

52. Click Yes to confirm.  The Financial Accounts List screen displays. 

53. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully deleted a financial account. 
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Managing Natural Accounts 

Adding a Natural Account 
In this scenario, you will add a natural account to the Financial Management module. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add a Natural Account: 

54. Display the Financial Management [Journal] screen. 

55. On the Journal menu, click Natural Accounts List.  The Natural Accounts List screen displays. 

56. Click Add.  The Natural Account screen displays in add mode. 

57. Enter a unique Natural Account Code. 

58. Enter the Natural Account Name. 

59. Select the Account Type. 

60. Select one of the following Normal Balance options: 

• Debit 

• Credit 

 
NOTE:  Select the Mandatory Account check box to indicate that the natural account is mandatory. 

 

 
NOTE:  Select the Agency Required check box to indicate that an agency must be selected when adding 
a journal entry to the natural account. 

61. Click OK.  The Natural Accounts List screen displays. 

62. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully added a natural account. 
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Editing a Natural Account 
In this scenario, you will edit or update a natural account. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit a Natural Account: 

63. Display the Financial Management [Journal] screen. 

64. On the Journal menu, click Natural Accounts List.  The Natural Accounts List screen displays. 

65. Select a natural account from within the Natural Account List table. 

66. Click Edit.  The Natural Account screen displays in edit mode. 

67. Enter or edit screen information as necessary. 

 
NOTE:  Select the Mandatory Account check box to indicate that the natural account is mandatory. 

 

 
NOTE:  Select the Agency Required check box to indicate that an agency must be selected when adding 
a journal entry to the natural account. 

68. Click OK.  The Natural Accounts List screen displays. 

69. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully edited a natural account. 
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Deleting a Natural Account 
In this scenario, you will delete a natural account. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Delete a Natural Account: 

70. Display the Financial Management [Journal] screen. 

71. On the Journal menu, click Natural Accounts List.  The Natural Accounts List screen displays. 

72. Select a natural account from within the Natural Accounts List table to delete. 

73. Click Delete.  A confirmation message displays. 

74. Click Yes to confirm the deletion of the account.  The Natural Accounts List screen displays. 

75. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully deleted a natural account. 
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Managing Financial Statement Variant Years 

Adding a Financial Statement Variant Year 
In this scenario, you will add a financial statement variant year and generate new fund obligation variants. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add a Financial Statement Variant Year: 

76. Display the Financial Management [Journal] screen. 

77. On the Journal menu, click Financial Statements List.  The Financial Statements List screen displays. 

78. Select a line from within the Financial Statements List table. 

79. Click Fund Variant List.  The Financial Statement Fund Variant List screen displays.   

80. Click Add Year.  The Add Financial Statement Variant Year screen displays. 

 
NOTE:  Click Details to view detailed information about a statement fund variant that is currently 
associated with a financial statement. 

81. Enter the Calendar Year of the new financial statement variant year to generate new fund obligation 
variants. 

82. Click OK.  The Financial Statements List screen displays. 

83. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully added a financial statement variant year. 
 

108 



T R A I N I N G  S C E N A R I O S  

 

Editing a Financial Statement Fund Variant 
In this scenario, you will edit or update a fund variant that is associated with an financial statement. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit a Financial Statement Fund Variant: 

84. Display the Financial Management [Journal] screen. 

85. On the Journal menu, click Financial Statements List.  The Financial Statements List screen displays. 

86. Select a line from within the Financial Statements List table. 

87. Click Fund Variant List.  The Financial Statement Fund Variant List screen displays. 

88. Select the Show Variants for the Year.  The Financial Statement Fund Variant List table will update. 

89. Select a statement variant from within the table. 

90. Click Edit.  The Financial Statement Fund Variant screen displays in edit mode. 

91. Edit or update screen information as necessary. 

92. Click OK.  The Financial Statement Fund Variant List screen displays. 

93. Click Close.  The Financial Statements List screen displays. 

94. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully edited (or update) a statement fund variant. 
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Managing Financial Statements 

Editing a Financial Statement 
In this scenario, you will edit (or update) a financial statement. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit a Financial Statement: 

95. Display the Financial Management [Journal] screen. 

96. On the Journal menu, click Financial Statements List.  The Financial Statements List screen displays. 

97. Select a financial statement in the Financial Statements List table. 

98. Click Edit.  The Financial Statement screen displays in edit mode. 

99. Edit or update screen information as necessary. 

100. Click OK.  The Financial Statements List screen displays. 

101. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully edited (or updated) a financial statement. 
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Adding a Financial Statement Line 
In this scenario, you will add a statement line to a financial statement line list currently associated with a financial 
statement. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add a Financial Statement Line to a Financial Statement 
Line List: 

102. Display the Financial Management [Journal] screen. 

103. On the Journal menu, click Financial Statements List.  The Financial Statements List screen 
displays. 

104. Click Statement Line List.  The Financial Statement Line List screen displays. 

105. Click Add.  The Financial Statement Line screen displays in add mode. 

106. Enter the Page #. 

107. Enter the Row ID. 

108. Enter the Description. 

109. Click OK.  The Financial Statements List screen displays. 

110. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully added a financial statement line to a financial statement line list. 
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Editing a Financial Statement Line 
In this scenario, you will edit (or update) a statement line in a financial statement line list that is currently 
associated with a financial statement. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit a Financial Statement Line: 

111. Display the Financial Management [Journal] screen. 

112. On the Journal menu, click Financial Statements List.  The Financial Statements List screen 
displays. 

113. Select the statement within the Financial Statements List table 

114. Click Statement Line List.  The Financial Statement Line List screen displays. 

115. Select a statement line from within the Financial Statement Line List table to edit or update. 

116. Click Edit.  The Financial Statement Line screen displays in edit mode. 

117. Enter or update the Description of the line. 

118. Click OK.  The Financial Statement Line List screen displays. 

119. Click Close.  The Financial Statements List screen displays. 

120. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully edited (or updated) a financial statement line within a financial statement 
line list. 

 

112 



T R A I N I N G  S C E N A R I O S  

Viewing the Details of a Financial Statement Line 
In this scenario, you will learn how to view detailed information of a financial statement line within a financial 
statement line list. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to View Details of a Financial Statement Line: 

121. Display the Financial Management [Journal] screen. 

122. On the Journal menu, click Financial Statements List.  The Financial Statements List screen 
displays. 

123. Select the statement within the Financial Statements List table 

124. Click Statement Line List.  The Financial Statement Line List screen displays. 

125. Select a statement line from within the Financial Statement Line List table to edit or update. 

126. Click Details.  The Financial Statement Line screen displays in details mode. 

127. View details of the financial statement line. 

128. Click Close.  The Financial Statement Line List screen displays. 

129. Click Close.  The Financial Statements List screen displays. 

130. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully viewed details of a financial statement line within a financial statement 
line list. 
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Deleting a Financial Statement Line 
In this scenario, you will delete a financial statement line from a financial statement line list. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Delete a Financial Statement Line: 

131. Display the Financial Management [Journal] screen. 

132. On the Journal menu, click Financial Statements List.  The Financial Statements List screen 
displays. 

133. Select the statement within the Financial Statements List table 

134. Click Statement Line List.  The Financial Statement Line List screen displays. 

135. Select a statement line from within the Financial Statement Line List table. 

136. Click Delete.  A confirmation message displays. 

137. Click Yes.  The Financial Statement Line List screen displays. 

138. Click Close.  The Financial Statements List screen displays. 

139. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully deleted a financial statement line from a financial statement line list. 
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Adding a Line Account 
In this scenario, you will add a line account to a line on a financial statement line list. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add a Line Account to a Line on a Financial Statement 
Line List: 

140. Display the Financial Management [Journal] screen. 

141. On the Journal menu, click Financial Statements List.  The Financial Statements List screen 
displays. 

142. Select the statement within the Financial Statements List table 

143. Click Statement Line List.  The Financial Statement Line List screen displays. 

144. Select a statement line from within the Financial Statement Line List table. 

145. Click Account List.  The Financial Statement Line Account List screen displays. 

146. Click Add.  The Financial Statement Line Account screen displays in add mode. 

147. Select a Financial Account. 

148. Select at least one Natural Account. 

149. Click OK.  The Financial Statement Line Account List screen displays. 

150. Click Close.  The Financial Statement Line List screen displays. 

151. Click Close.  The Financial Statements List screen displays. 

152. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully added a line account to a line on a financial statement line list. 
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Editing a Line Account 
In this scenario, you will edit a line account. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit a Line Account: 

153. Display the Financial Management [Journal] screen. 

154. On the Journal menu, click Financial Statements List.  The Financial Statements List screen 
displays. 

155. Select the statement within the Financial Statements List table 

156. Click Statement Line List.  The Financial Statement Line List screen displays. 

157. Select a line from within the Financial Statement Line List table. 

158. Click Account List.  The Financial Statement Line Account List screen displays. 

159. Select an account from within the Financial Statement Line Account List table. 

160. Click Edit.  The Financial Statement Line Account screen displays in edit mode. 

161. Select a Financial Account check box selections. 

162. Click OK.  The Financial Statement Line Account List screen displays. 

163. Click Close.  The Financial Statement Line List screen displays. 

164. Click Close.  The Financial Statements List screen displays. 

165. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully edited a line account associated with a line on a financial statement line 
list. 
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Viewing a List of Accounts 
In this scenario, you will learn how to view a list of financial and natural accounts associated with the lines on a 
financial statement line list. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to View a List of Accounts: 

166. Display the Financial Management [Journal] screen. 

167. On the Journal menu, click Financial Statements List.  The Financial Statements List screen 
displays. 

168. Select the statement within the Financial Statements List table 

169. Click Statement Line List.  The Financial Statement Line List screen displays. 

170. Select a statement line from within the Financial Statement Line List table. 

171. Click Account List.  The Financial Statement Line Account List screen displays. 

172. View the financial accounts and natural accounts associated with the financial statement line within  the 
Financial Statement Line Account List table. 

173. Click Close.  The Financial Statement Line List screen displays. 

174. Click Close.  The Financial Statements List screen displays. 

175. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully viewed a list of accounts associated with a line on a financial statement 
line list. 
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Deleting a Line Account 
In this scenario, you will delete a line account associated with a line on a financial statement line list. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Delete a Line Account: 

176. Display the Financial Management [Journal] screen. 

177. On the Journal menu, click Financial Statements List.  The Financial Statements List screen 
displays. 

178. Select the statement within the Financial Statements List table 

179. Click Statement Line List.  The Financial Statement Line List screen displays. 

180. Select a line from within the Financial Statement Line List table. 

181. Click Account List.  The Financial Statement Line Account List screen displays. 

182. Select an account from within the Financial Statement Line Account List table. 

183. Click Delete.  A confirmation message displays. 

184. Click Yes to confirm.  The Financial Statement Line Account List screen displays. 

185. Click OK.  The Financial Statement Line Account List screen displays. 

186. Click Close.  The Financial Statement Line List screen displays. 

187. Click Close.  The Financial Statements List screen displays. 

188. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully deleted a line account associated with a line on a financial statement line 
list. 
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Managing Journals 

Searching for a Journal Transaction 
In this scenario, you will use the Filter Journal View screen to search for journal transactions and filter the list of 
journal entries that display on the Financial Management [Journal] screen. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Search for a Journal Transaction: 

189. Display the Financial Management [Journal] screen. 

190. Click the Filter Journal View toolbar button.  The Filter Journal View screen displays. 

191. Enter or select one or more of the following options: 

• Journal ID 

• Accounting Period 

• Journal Type 

• Fund 

• Financial Account 

• Natural Account 

• Agency 

• Status 

• Value Type 

• Created by 

 
NOTE:  Select the Select by Transaction Date check box and enter or select the Starting and Ending 
dates to search for a journal transaction within a specific date range. 

 

 
NOTE:  Select the Sort by Transaction Date check box to sort journal transactions by transaction date. 

192. Click OK.  The Filter Journal View table displays results matching your search criteria. 

 
NOTE:  Click the Filter Journal View toolbar button and repeat the process if no results were found. 

Congratulations!  You used the Filter Journal View screen to search for journal transactions and filter the list of 
journal entries that display on the Financial Management [Journal] screen. 
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Adding a Journal 
In this scenario, you will add a journal. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add a Journal: 

193. Display the Financial Management [Journal] screen. 

194. Click Add Journal.  The Journal screen displays in add mode. 

195. Select the Accounting Period. 

196. Select a Value Type: 

• Actual 

• Budget 

• Forecast 

197. Select the Journal Type. 

198. Enter the Journal Description. 

199. Select one of the following buttons: 

• Suspend 

• Import 

• Post 

 
NOTE:  Select a journal transaction in the Add Journal table and click one of the following buttons to 
work with or view information listed within the table: 
• Add Trans 
• Edit Trans 
• Delete Trans 
• Details 

Congratulations!  You have successfully added a journal. 
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Editing a Journal 
In this scenario, you will edit a journal. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit a Journal: 

200. Display the Financial Management [Journal] screen. 

201. Search for Journal Transactions. 

202. Select a journal to edit or update in the Financial Management [Journal] table. 

203. On the Journal menu, click Edit.  The Journal screen displays in edit mode. 

204. Edit or update the Accounting Period if necessary. 

 
NOTE:  The Accounting Period cannot be edited or updated after a transaction has been added to the 
journal. 

205. Edit or update the Value Type: 

206. Edit or update the Journal Type. 

207. Edit or update the Journal Description. 

 
NOTE:  The Edit Journal table displays a list of all journal transactions that are associated with the 
journal.  Select the following buttons to work with or view transactions: 
• Add Trans 
• Edit Trans 
• Delete Trans 
• Details 

208. Select one of the following to save information for the journal: 

• Suspend 

• Import 

• Post 

Congratulations!  You have successfully edited or updated a journal. 
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Deleting a Journal 
In this scenario, you will delete a journal. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Delete a Journal: 

209. Display the Financial Management [Journal] screen. 

210. Search for Journal Transactions. 

211. Select a journal to edit or update in the Financial Management [Journal] table. 

212. On the Journal menu, click Edit.  The Journal screen displays in edit mode. 

213. Click Delete Entry.  A confirmation message displays. 

214. Click Yes to confirm.  The Financial Management [Journal] table displays. 

Congratulations!  You have successfully deleted a journal. 
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Adding a Journal Transaction 
In this scenario, you will add a journal transaction. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add a Journal Transaction to a Journal: 

215. Display the Financial Management [Journal] screen. 

216. Select a journal in the Financial Management [Journal] table. 

217. On the Journal menu, click Edit.  The Journal screen displays in edit mode. 

218. Click Add Trans.  The Journal Transaction screen displays in add mode. 

219. Enter the Transaction Date. 

220. Select the Fund. 

221. Select the Financial Account. 

222. Select the Natural Account. 

223. Select the Agency. 

224. Enter one of the following: 

• Debit 

• Credit 

225. Enter the Transaction Description. 

226. Click Save.  The Journal screen displays in edit mode. 

Congratulations!  You have successfully added a journal transaction to a journal. 
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Importing a List of Journal Entries 
In this scenario, you will import a list of journal entries. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Import a List of Journal Entries: 

227. Display the Financial Management [Journal] screen. 

228. Select a journal in the Financial Management [Journal] table. 

229. On the Journal menu, click Edit.  The Journal screen displays in edit mode. 

230. Click Import.  The Import Journal Entry screen displays. 

231. Select the file to import. 

232. Click Open.  The Journal screen displays in edit mode. 

 
NOTE:  The Journal table displays the imported journal entries. 

Congratulations!  You have successfully deleted a journal. 
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Editing a Journal Transaction 
In this scenario, you will edit a journal transaction. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit a Journal Transaction: 

233. Display the Financial Management [Journal] screen. 

234. Select a journal in the Financial Management [Journal] table. 

235. On the Journal menu, click Edit.  The Journal screen displays in edit mode. 

236. Click Edit Trans.  The Journal Transaction screen displays in edit mode. 

237. Edit or update the following as necessary: 

• Enter the Transaction Date. 

• Select the Fund. 

• Select the Financial Account. 

• Select the Natural Account. 

• Select the Agency. 

• Enter one of the following: 
o Debit 
o Credit 

• Enter the Transaction Description. 

238. Click OK.  The Journal screen displays in edit mode. 

Congratulations!  You have successfully edited or updated a journal transaction that is associated with a journal. 
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Posting a Journal 
In this scenario, you will post a journal. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Post a Journal: 

239. Display the Financial Management [Journal] screen. 

240. Select a journal in the Financial Management [Journal] table. 

241. On the Journal menu, click Edit.  The Journal screen displays in edit mode. 

242. Click Post.  The Financial Management [Journal] screen displays in edit mode. 

Congratulations!  You have successfully posted a journal. 
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Viewing the Details of a Journal 
In this scenario, you will view the details of a journal. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to View the Details of a Journal: 

243. Display the Financial Management [Journal] screen. 

244. Select a journal in the Financial Management [Journal] table. 

 
NOTE:  Search for journals (Filter Journal Transactions) if no journals are listed in the Financial 
Management [Journal] table. 

245. On the Journal menu, click Details.  The Journal screen displays in details mode. 

246. View Journal details. 

 
NOTE:  Select journal transactions in the Journal table and click Details to view detailed information 
about the journal transactions listed. 

247. Click Close.  The Financial Management [Journal] screen displays. 

Congratulations!  You have successfully viewed the details of a journal. 
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Viewing Account Activity (Financial Account Inquiry) 
In this scenario, you will use the Financial Account Inquiry screen to view the account activity for a filtered list of 
journals in a balance column accounting sheet. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to View Account Activity (Financial Account Inquiry): 

248. Display the Financial Management [Journal] screen. 

249. On the Journal menu, click Financial Account Inquiry.  The Financial Account Inquiry screen 
displays. 

250. Enter or select the following: 

• Fund 

• Financial Account 

• Natural Account 

• Journal Type 

• Accounting Period 

• Value Type 

 
NOTE:  Enter or select the following to further filter search criteria: 
• Transaction from 
• Through 
• Post Period Items Only 

251. Click Search.  The Financial Account Inquiry table will be update to display account activity 
matching your search criteria. 

 
NOTE:  Enter or select new search criteria and click Search to display different account activity. 

252. Click Close when you have finished viewing account activity.  The Financial Management [Journal] 
screen displays. 

Congratulations!  You have successfully viewed account activity by using the Financial Account Inquiry screen. 
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Managing Rebate Suppliers 

Adding a Rebate Supplier 
In this scenario, you will add a Rebate Supplier.  You will document contact, product, and agreement rebate 
supplier information. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add a Rebate Supplier: 

253. Display the Financial Management [Journal] screen. 

254. On the View menu, click Rebate Suppliers.  The Financial Management [Rebate Suppliers] 
screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

255. On the Rebate Suppliers menu, click Add.  The Rebate Supplier screen displays in add mode. 

256. Enter Contact information. 

 
NOTE:  The Rebate Supplier screen includes the Contact, Products, and Agreements tabs. 
 Information can be entered on all three screens; however, only the Contact screen must be completed to 
add a rebate supplier. 

257. Click the Products tab.  The Products tab displays. 

258. Click Add.  The Product screen displays in add mode. 

259. Enter product information. 

260. Click OK. 

 
NOTE:  Click Add and repeat steps 6–8 to add additional products. 

261. Click the Agreements tab.  The Agreements screen displays. 

262. Click Add.  The Rebate Agreement screen displays in add mode. 

 
NOTE:  The Rebate Agreement  screen has two tabs.  Complete the Agreements screen first, and then 
complete the Rebate Items screen. 

263. Enter agreement information. 
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NOTE:  Select the Allow Mid–term Rebate Adjustments option, if applicable, to allow mid-term rebate 
adjustments. 

264. Click the Rebate Items tab.  A confirmation message displays. 

265. Click Yes.  The Rebate Items screen displays. 

266. Enter or select the Rebate Billed As of date. 

 
NOTE:  Click the Add Rebate Schedule button, if applicable, to add a rebate schedule.  This button is 
only available if the rebate agreement allows mid-term adjustments and then only if a rebate product has 
been selected for the current rebate schedule.  The Add Rebate Schedule screen displays when clicked. 

267. Click Select Rebate Products.  The Select Rebate Products screen displays. 

268. Select a rebate product listed in the Select Rebate Products table. 

269. Click Select.  The Rebate Item screen displays. 

270. Select a rebate item in the Food Distribution Item Inventory table. 

271. Click the arrow button pictured below.  The selected rebate item displays under the Items Related to 
Selected Rebate Product table. 

 

272. Enter the Rebate Per Unit Amount. 

273. Click OK. 

274. Click OK. 

275. Click OK. 

 
NOTE:  On the View menu, click Journal to display the Financial Management [Journal] screen. 

Congratulations!  You have successfully added a rebate supplier. 
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Editing a Rebate Supplier 
In this scenario, you will edit existing rebate supplier information. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit a Rebate Supplier: 

276. Display the Financial Management [Journal] screen. 

277. Click View in the menu bar and select Rebate Suppliers.  The Financial Management [Rebate 
Suppliers] screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

278. Select a rebate supplier in the Financial Management [Rebate Suppliers] table. 

279. On the Rebate Suppliers menu, click Edit.  The Rebate Supplier screen displays in edit mode. 

280. Edit (or update) Contact information. 

281. Click the Products tab.  The Products screen displays. 

282. Edit (or update) product information as necessary. 

 
NOTE:  Select a product and click Edit to edit (or update) product information. 

283. Click the Agreements tab.  The Agreements screen displays. 

284. Edit (or update) agreement and rebate item information as necessary. 

 
NOTE:  Select an agreement click Edit to edit (or update) agreement information.  Click the Rebate Item 
tab to edit rebate item information. 

285. Click OK. 

 
NOTE:  Click View in the menu bar and select Journal to display the Financial Management [Journal] 
screen. 

Congratulations!  You have successfully edited a rebate supplier. 
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Viewing the Details of a Rebate Supplier 
In this scenario, you will access the Rebate Supplier screen.  You can view detailed information about any rebate 
supplier. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to View the Details of a Rebate Supplier: 

286. Display the Financial Management [Journal] screen. 

287. Click View in the menu bar and select Rebate Suppliers.  The Financial Management [Rebate 
Suppliers] screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

288. Select a rebate supplier in the Financial Management [Rebate Suppliers] table. 

289. On the Rebate Suppliers menu, click Details.  The Rebate Supplier screen displays in details mode. 

290. Click the following tabs to view detailed information about the selected supplier: 

• Contact 

• Products 

• Agreements 

 
NOTE:  Information displayed in the Rebate Supplier screen and its tabs is read-only.  Click Rebate 
Suppliers in the menu bar and select one of the following to add or edit supplier information: 
• Add – to add a supplier  
• Edit – to edit (or update) supplier information. 

 

 
NOTE:  Click Details on the Product and Agreements tabs to display detailed information on supplier 
products and agreements. 

291. Click Close when you are finished viewing rebate suppliers.  The Financial Management [Rebate 
Suppliers] screen displays. 

 
NOTE:  Click View in the menu bar and select Journal to display the Financial Management [Journal] 
screen. 

Congratulations!  You have successfully viewed rebate suppliers and detailed supplier information. 
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Deleting a Rebate Supplier 
In this scenario, you will delete a rebate supplier. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Delete a Rebate Supplier: 

292. Display the Financial Management [Journal] screen. 

293. Click View in the menu bar and select Rebate Suppliers.  The Financial Management [Rebate 
Suppliers] screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

294. Select a rebate supplier in the Financial Management [Rebate Suppliers] table. 

295. Click Rebate Suppliers in the menu bar and select Delete.  A confirmation message displays. 

296. Click Yes to confirm.  The Financial Management [Rebate Suppliers] screen displays. 

 
NOTE:  Click View in the menu bar and select Journal to display the Financial Management [Journal] 
screen. 

Congratulations!  You have successfully deleted a rebate supplier. 
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Managing Rebate Products 
Adding a Rebate Product 

In this scenario, you will add a rebate product. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add a Rebate Product: 

297. Display the Financial Management [Journal] screen. 

298. Click View in the menu bar and select Rebate Suppliers.  The Financial Management [Rebate 
Suppliers] screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

299. Select a rebate supplier in the Financial Management [Rebate Suppliers] table. 

300. Click Rebate Suppliers in the menu bar and select Edit.  The Rebate Supplier screen displays in edit 
mode. 

301. Click the Products tab.  The Products screen displays. 

302. Click Add.  The Product screen displays in add mode. 

303. Enter product information. 

304. Click OK. 

 
NOTE:  Repeat steps 6–8, as necessary, to add additional products. 

305. Click OK. 

 
NOTE:  On the View menu, click Journal to display the Financial Management [Journal] screen. 

Congratulations!  You have successfully added a rebate product. 
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Editing a Rebate Product 
In this scenario, you will edit rebate product information. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit a Rebate Product: 

306. Display the Financial Management [Journal] screen. 

307. Click View in the menu bar and select Rebate Suppliers.  The Financial Management [Rebate 
Suppliers] screen displays. 

 
NOTE:  All rebate suppliers are listed in the Financial Management [Rebate Suppliers] table. 

308. Select a rebate product in the Financial Management [Rebate Suppliers] table. 

309. On the Rebate Suppliers menu, click Edit.  The Rebate Supplier screen displays in edit mode. 

310. Click the Products tab.  The Products screen displays. 

311. Select a product. 

312. Click Edit.  The Product screen displays in edit mode. 

313. Edit (or update) product information as necessary. 

314. Click OK. 

315. Click OK. 

 
NOTE:  On the View menu, click Journal to display the Financial Management [Journal] screen. 

Congratulations!  You have successfully edited (or updated) a rebate product. 
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Viewing the Details of a Rebate Product 
In this scenario, you will learn how to view detailed information about rebate products. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to View the Details of a Rebate Product: 

316. Display the Financial Management [Journal] screen. 

317. Click View in the menu bar and select Rebate Suppliers.  The Financial Management [Rebate 
Suppliers] screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

318. Select a rebate product in the Financial Management [Rebate Suppliers] table. 

319. Click Rebate Suppliers in the menu bar and select Details.  The Rebate Supplier screen displays in 
details mode. 

320. Click the Products tab.  The Products screen displays. 

321. Click Details on the Product. 

322. Click Close when you are finished viewing rebate products. 

 
NOTE:  On the View menu, click Journal to display the Financial Management [Journal] screen. 

Congratulations!  You have successfully viewed Rebate Suppliers and detailed supplier information. 
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Deleting a Rebate Product 
In this scenario, you will delete a rebate product. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Delete a Rebate Product: 

323. Display the Financial Management [Journal] screen. 

324. Click View in the menu bar and select Rebate Suppliers.  The Financial Management [Rebate 
Suppliers] screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

325. Select a rebate product in the Financial Management [Rebate Suppliers] table. 

326. Click Rebate Suppliers in the menu bar and select Edit.  The Rebate Supplier screen displays in edit 
mode. 

327. Click the Products tab.  The Products screen displays. 

328. Select a product. 

329. Click Delete.  A confirmation message displays. 

330. Click Yes to confirm. 

331. Click OK. 

 
NOTE:  On the View menu, click Journal to display the Financial Management [Journal] screen. 

Congratulations!  You have successfully deleted a rebate product. 
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Managing Rebate Agreements 
Adding a Rebate Agreement 

In this scenario, you will use the Rebate Supplier screen to add a new rebate agreement for an existing rebate 
supplier. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add a Rebate Agreement: 

332. Display the Financial Management [Journal] screen. 

333. On the View menu, click Rebate Suppliers.  The Financial Management [Rebate Suppliers] 
screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

334. Select a rebate supplier in the Financial Management [Rebate Suppliers] table. 

335. On the Rebate Suppliers menu, click Edit.  The Rebate Supplier screen displays in add mode. 

336. Click the Agreements tab.  The Agreements screen displays. 

337. Click Add.  The Rebate Agreement screen displays in add mode. 

 
NOTE:  The Rebate Agreement screen has two tabs.  For this scenario, you will complete the 
Agreements screen. 

338. Select a Commodity upon which the agreement is based. 

339. Enter a title for the agreement in Agreement Title. 

340. Enter or select the date on which the agreement becomes effective in Effective. 

341. Enter or select the date on which the agreement expires in through. 

342. Enter the street address to which bills are sent for the agreement in Billing Address.  Additional street 
address information can be entered in the secondary box. 

343. Enter the City to which bills are sent for the agreement. 

344. Select the State to which bills are sent for the agreement. 

345. Enter the five- or nine-digit code for the postal zone to which bills are to be sent for the agreement in 
ZIP. 

346. Enter the contact's title in Contact Salutation.  (For example, Mr., Mrs., Miss, Ms., Dr., and so on.) 

347. Enter the contact's first name in Contact First Name. 

348. Enter the contact's last name in Contact Last Name. 
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349. Enter the contact's telephone number in Telephone. 

350. Enter the contact's Fax Number. 

351. Select the Allow Mid–term Rebate Adjustments check box to set the agreement to allow mid–term 
rebate adjustments as necessary. 

 
NOTE:  You can also click the Rebate Items tab to view and work with the rebate products associated 
with the rebate supplier, but it is not required when adding a new rebate agreement. 

352. Click OK. 

 
NOTE:  On the View menu, click Journal to display the Financial Management [Journal] screen. 

Congratulations!  You have successfully used the Rebate Supplier screen to add a new rebate agreement for an 
existing rebate supplier. 
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Editing a Rebate Agreement 
In this scenario, you will use the Rebate Supplier screen to update an existing rebate agreement for a rebate 
supplier. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit a Rebate Agreement: 

353. Display the Financial Management [Journal] screen. 

354. On the View menu, click Rebate Suppliers.  The Financial Management [Rebate Suppliers] 
screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

355. Select a rebate supplier in the Financial Management [Rebate Suppliers] table. 

356. On the Rebate Suppliers menu, click Edit.  The Rebate Supplier screen displays in add mode. 

357. Click the Agreements tab.  The Agreements screen displays. 

358. Select a rebate agreement in the Agreements table. 

359. Click Edit.  The Rebate Agreement screen displays in edit mode. 

 
NOTE:  The Rebate Agreement screen has two tabs.  For this scenario, you will update the Agreements 
screen. 

360. Update the following agreement information for the rebate agreement as necessary: 

• Commodity 

• Agreement Title 

• Effective 

• through 

• Billing Address 

• City 

• State 

• ZIP 

• Contact Salutation 

• Contact First Name 

• Contact Last Name 

• Telephone 

• Fax Number 

• Allow Mid–term Rebate Adjustments 
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NOTE:  You can also click the Rebate Items tab to view and work with the rebate products associated 
with the rebate supplier, but it is not required when updating a rebate agreement. 

361. Click OK. 

 
NOTE:  On the View menu, click Journal to display the Financial Management [Journal] screen. 

Congratulations!  You have successfully used the Rebate Supplier screen to update an existing rebate agreement 
for a rebate supplier. 
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Viewing the Details of a Rebate Agreement 
In this scenario, you will use the Rebate Supplier screen to view the details of an existing rebate agreement for a 
rebate supplier. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to View the Details of a Rebate Agreement: 

362. Display the Financial Management [Journal] screen. 

363. On the View menu, click Rebate Suppliers.  The Financial Management [Rebate Suppliers] 
screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

364. Select a rebate supplier in the Financial Management [Rebate Suppliers] table. 

365. On the Rebate Suppliers menu, click Edit.  The Rebate Supplier screen displays in add mode. 

366. Click the Agreements tab.  The Agreements screen displays. 

367. Select a rebate agreement in the Agreements table. 

368. Click Details.  The Rebate Agreement screen displays in details mode. 

369. View the following agreement information for the rebate agreement as necessary: 

• Commodity 

• Agreement Title 

• Effective 

• through 

• Billing Address 

• City 

• State 

• ZIP 

• Contact Salutation 

• Contact First Name 

• Contact Last Name 

• Telephone 

• Fax Number 

• Allow Mid–term Rebate Adjustments 

370. Click the Rebate Items tab.  The Rebate Items screen displays. 

371. View the rebate schedule effective date in Rebate Billed as of. 
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372. View the list of rebate items currently associated with the rebate agreement in the Rebate Items tree 
list. 

373. Click Close when you are finished viewing the details of the rebate agreement. 

 
NOTE:  On the View menu, click Journal to display the Financial Management [Journal] screen. 

Congratulations!  You have successfully used the Rebate Supplier screen to view the details of an existing rebate 
agreement for a rebate supplier. 
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Deleting a Rebate Agreement 
In this scenario, you will use the Rebate Supplier screen to delete an existing rebate agreement. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Delete a Rebate Agreement: 

374. Display the Financial Management [Journal] screen. 

375. On the View menu, click Rebate Suppliers.  The Financial Management [Rebate Suppliers] 
screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

376. Select a rebate supplier in the Financial Management [Rebate Suppliers] table. 

377. On the Rebate Suppliers menu, click Edit.  The Rebate Supplier screen displays in add mode. 

378. Click the Agreements tab.  The Agreements screen displays. 

379. Select a rebate agreement in the Agreements table. 

380. Click Delete.  A confirmation message displays confirming your request. 

381. Click Yes. 

Congratulations!  You have successfully used the Rebate Supplier screen to delete an existing rebate agreement. 
 

144 



T R A I N I N G  S C E N A R I O S  

Managing Rebate Items 
Adding a Rebate Item 

In this scenario, you will use the Rebate Agreement screen to add a new food item to a rebate product for an 
existing rebate supplier's rebate agreement. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add a Rebate Item: 

382. Display the Financial Management [Journal] screen. 

383. On the View menu, click Rebate Suppliers.  The Financial Management [Rebate Suppliers] 
screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

384. Select a rebate supplier in the Financial Management [Rebate Suppliers] table. 

385. On the Rebate Suppliers menu, click Edit.  The Rebate Supplier screen displays in add mode. 

386. Click the Agreements tab.  The Agreements screen displays. 

387. Select a rebate agreement in the Agreements table. 

388. Click Edit.  The Rebate Agreement screen displays in edit mode. 

 
NOTE:  The Rebate Agreement screen has two tabs.  For this scenario, you will use the Rebate Items 
screen. 

389. Click the Rebate Items tab.  The Rebate Items screen displays. 

390. Click the Select Rebate Products tab.  The Select Rebate Products screen displays. 

 
NOTE:  The Select Rebate Products table displays a list of all the rebate products that currently exist 
within the rebate agreement for the rebate supplier 

391. Select a product in the Select Rebate Products table. 

392. Click Select.  The Rebate Item screen displays. 

 
NOTE:  A list of all the food items that have already been added to the rebate product for the rebate 
agreement is displayed in the Items Related to Selected Rebate Product list. 

393. Enter rebate amount per unit for the rebate item in Rebate Per Unit Amount. 

394. Select an item in the Food Distribution Item Inventory list. 
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395. Click the Select button (pictured below) to move the item to the Items Related to Selected Rebate 
Product list. 

 

396. Click OK. 

Congratulations!  You have successfully used the Rebate Agreement screen to add a new food item to a rebate 
product for an existing rebate supplier's rebate agreement. 
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Editing Rebate Items 
In this scenario, you will use the Rebate Agreement screen to update the list of food items currently associated 
with a rebate product within an existing rebate agreement for a rebate supplier. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit Rebate Items: 

397. Display the Financial Management [Journal] screen. 

398. On the View menu, click Rebate Suppliers.  The Financial Management [Rebate Suppliers] 
screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

399. Select a rebate supplier in the Financial Management [Rebate Suppliers] table. 

400. On the Rebate Suppliers menu, click Edit.  The Rebate Supplier screen displays in add mode. 

401. Click the Agreements tab.  The Agreements screen displays. 

402. Select a rebate agreement in the Agreements table. 

403. Click Edit.  The Rebate Agreement screen displays in edit mode. 

 
NOTE:  The Rebate Agreement screen has two tabs.  For this scenario, you will use the Rebate Items 
screen. 

404. Click the Rebate Items tab.  The Rebate Items screen displays. 

405. Select a rebate schedule effective date in Rebate Billed as of. 

 
NOTE:  The items displayed in the Rebate Items tree list are refreshed whenever a rebate schedule 
effective date is selected in Rebate Billed as of. 

406. Select a rebate item in the Rebate Items tree list. 

407. Click Edit.  The Rebate Item screen displays. 

408. To add additional items to the rebate agreement, select an item in the Food Distribution Item 
Inventory list and click the Select button (pictured below) to move the item to the Items Related to 
Selected Rebate Product list. 

 

409. To remove existing items from the rebate agreement, select an item in the Items Related to Selected 
Rebate Product list and click the Remove button (pictured below) to move the food item to the Food 
Distribution Item Inventory list. 
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410. Click OK. 

Congratulations!  You have successfully used the Rebate Agreement screen to update the list of food items 
currently associated with a rebate product within an existing rebate agreement for a rebate supplier. 
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Removing a Rebate Item 
In this scenario, you will use the Rebate Agreement screen to remove a food item that is currently associated 
with a rebate product from an existing rebate agreement for a rebate supplier. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Remove a Rebate Item: 

411. Display the Financial Management [Journal] screen. 

412. On the View menu, click Rebate Suppliers.  The Financial Management [Rebate Suppliers] 
screen displays. 

 
NOTE:  All rebate suppliers that currently exist within the system will be listed in the Financial 
Management [Rebate Suppliers] table. 

413. Select a rebate supplier in the Financial Management [Rebate Suppliers] table. 

414. On the Rebate Suppliers menu, click Edit.  The Rebate Supplier screen displays in add mode. 

415. Click the Agreements tab.  The Agreements screen displays. 

416. Select a rebate agreement in the Agreements table. 

417. Click Edit.  The Rebate Agreement screen displays in edit mode. 

 
NOTE:  The Rebate Agreement screen has two tabs.  For this scenario, you will use the Rebate Items 
screen. 

418. Click the Rebate Items tab.  The Rebate Items screen displays. 

419. Click the Select Rebate Products tab.  The Select Rebate Products screen displays. 

 
NOTE:  The Select Rebate Products table displays a list of all the rebate products that currently exist 
within the rebate agreement for the rebate supplier 

420. Select a product in the Select Rebate Products table. 

421. Click Select.  The Rebate Item screen displays. 

 
NOTE:  A list of all the food items that have already been added to the rebate product for the rebate 
agreement is displayed in the Items Related to Selected Rebate Product list. 

422. Select the item to remove in the Items Related to Selected Rebate Product list. 

423. Click the Remove button (pictured below) to move the item to the Food Distribution Item 
Inventory list. 

 

424. Click OK. 
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Congratulations!  You have successfully used the Rebate Agreement screen to remove a food item that is 
currently associated with a rebate product from an existing rebate agreement for a rebate supplier. 
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Managing Rebate Suppliers' Accounts 

Viewing a Rebate Supplier's Account 
In this scenario, you will view a rebate supplier's account on the Rebate Supplier Account screen. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to View a Rebate Supplier's Account: 

425. Display the Financial Management [Rebate Suppliers] screen. 

426. Select a rebate supplier in the Rebate Suppliers table. 

427. On the Rebate Suppliers menu, click Rebate Supplier Account.  The Rebate Supplier Account 
screen displays. 

428. View the invoice account transactions in the Account Transaction table. 

Congratulations!  You have successfully viewed a rebate supplier's account on the Rebate Supplier Account 
screen. 
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Adding a Transaction to a Rebate Supplier's Account 
In this scenario, you will use the Account Transaction screen to add a transaction to a rebate supplier's account. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Add a Transaction to a Rebate Supplier's Account: 

429. Display the Financial Management [Rebate Suppliers] screen. 

430. Select a rebate supplier in the Rebate Suppliers table. 

431. On the Rebate Suppliers menu, click Rebate Supplier Account.  The Rebate Supplier Account 
screen displays. 

432. Click Add.  The Account Transaction screen displays. 

433. Enter or select the Date on which the account transaction occurred. 

434. Select the Type of the account transaction. 

435. Enter the invoice identification number of the account transaction in Invoice ID. 

436. Enter the Amount of the account transaction. 

437. Enter the supplier check number for the account transaction in Reference. 

438. Enter any remarks or comments for the account transaction in Remarks. 

439. Click OK. 

Congratulations!  You have successfully used the Account Transaction screen to add a transaction to a rebate 
supplier's account. 
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Editing a Transaction on a Rebate Supplier's Account 
In this scenario, you will use the Account Transaction screen to update an existing transaction on a rebate 
supplier's account. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Edit a Transaction on a Rebate Supplier's Account: 

440. Display the Financial Management [Rebate Suppliers] screen. 

441. Select a rebate supplier in the Rebate Suppliers table. 

442. On the Rebate Suppliers menu, click Rebate Supplier Account.  The Rebate Supplier Account 
screen displays. 

443. Select a transaction in the Account Transaction table. 

444. Click Edit.  The Account Transaction screen displays. 

445. Update the following information as necessary: 

• Date 

• Type 

• Invoice ID 

• Amount 

• Reference 

• Remarks 

446. Click OK. 

Congratulations!  You have successfully used the Account Transaction screen to update an existing transaction 
on a rebate supplier's account. 
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Deleting a Transaction from a Rebate Supplier's 
Account 

In this scenario, you will use the Rebate Supplier Account screen to delete an existing transaction from a rebate 
supplier's account. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Delete a Transaction from a Rebate Supplier's Account: 

447. Display the Financial Management [Rebate Suppliers] screen. 

448. Select a rebate supplier in the Rebate Suppliers table. 

449. On the Rebate Suppliers menu, click Rebate Supplier Account.  The Rebate Supplier Account 
screen displays. 

450. Select a transaction in the Account Transaction table. 

451. Click Delete.  A confirmation message displays. 

452. Click Yes. 

Congratulations!  You have successfully used the Rebate Supplier Account screen to delete an existing 
transaction from a rebate supplier's account. 
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Viewing the Details of a Transaction on a Rebate 
Supplier's Account 

In this scenario, you will use the Account Transaction screen to view the details of an existing transaction on a 
rebate supplier's account. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to View the Details of a Transaction on a Rebate Supplier's 
Account: 

453. Display the Financial Management [Rebate Suppliers] screen. 

454. Select a rebate supplier in the Rebate Suppliers table. 

455. On the Rebate Suppliers menu, click Rebate Supplier Account.  The Rebate Supplier Account 
screen displays. 

456. Select a transaction in the Account Transaction table. 

457. Click Details.  The Account Transaction screen displays. 

458. View the detailed information for the transaction. 

459. Click Close when you are finished viewing the details of the transaction. 

Congratulations!  You have successfully used the Account Transaction screen to view the details of an existing 
transaction on a rebate supplier's account. 
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Viewing the Invoice Line Items for a Transaction on a 
Rebate Supplier's Account 

In this scenario, you will use the Invoice Item Detail screen to view the invoice line items for an existing 
transaction on a rebate supplier's account. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to View the Invoice Line Items for a Transaction on a Rebate 
Supplier's Account: 

460. Display the Financial Management [Rebate Suppliers] screen. 

461. Select a rebate supplier in the Rebate Suppliers table. 

462. On the Rebate Suppliers menu, click Rebate Supplier Account.  The Rebate Supplier Account 
screen displays. 

463. Select a transaction in the Account Transaction table. 

464. Click Show Invoice Items.  The Invoice Item Detail screen displays. 

465. View the invoice line items for the transaction. 

466. Click Close when you are finished viewing the details of the transaction. 

Congratulations!  You have successfully used the Invoice Item Detail screen to view the invoice line items for 
an existing transaction on a rebate supplier's account. 
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Printing a Rebate Invoice 
In this scenario, you will use the Print Rebate Invoice screen to print a rebate invoice. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Print a Rebate Invoice: 

467. Display the Financial Management [Rebate Suppliers] screen. 

468. Select a rebate supplier in the Rebate Suppliers table. 

469. On the Rebate Suppliers menu, click Rebate Supplier Account.  The Rebate Supplier Account 
screen displays. 

470. Select a transaction in the Account Transaction table. 

471. Click Generate Invoice.  The Print Rebate Invoice screen displays. 

472. Select an Accounting Period for which to generate an invoice. 

473. Enter the Number of Breastfed Infants to print on the invoice cover letter. 

474. Enter the Number of Non–breastfed Infants to print on the invoice cover letter. 

475. Select the Express Mail Reference check box to calculate billing adjustments and generate an adjusted 
invoice. 

476. Click OK. 

Congratulations!  You have successfully used the Print Rebate Invoice screen to print a rebate invoice. 
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Reprinting a Rebate Invoice 
In this scenario, you will use the Reprint Rebate Invoice screen to reprint a rebate invoice. 

 
NOTE:  Press the F1 key at any time to access help for the current application screen.  Each screen's help 
topic explains the screen's function and describes its content. 

Complete the Following Steps to Reprint a Rebate Invoice: 

477. Display the Financial Management [Rebate Suppliers] screen. 

478. Select a rebate supplier in the Rebate Suppliers table. 

479. On the Rebate Suppliers menu, click Rebate Supplier Account.  The Rebate Supplier Account 
screen displays. 

480. Select a transaction in the Account Transaction table. 

481. Click Reprint Invoice.  The Reprint Rebate Invoice screen displays. 

482. Enter the Invoice identification number to verify the invoice to be reprinted. 

483. Enter the Number of Breastfed Infants to print on the invoice cover letter. 

484. Enter the Number of Non–breastfed Infants to print on the invoice cover letter. 

485. Select the Express Mail Reference check box to calculate billing adjustments and generate an adjusted 
invoice. 

486. Click OK. 

Congratulations!  You have successfully used the Reprint Rebate Invoice screen to reprint a rebate invoice. 
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Windows XP Basics 
To begin using the SPIRIT WIC System, you must first learn how to work within the Windows XP operating 
system.  To help you learn the basics of Windows XP, the following information is available: 

• The Windows Desktop 

• Icons 

• Taskbar 

• Start Menu 

• Files and Folders 

• Windows 

• Control Panel 

• Ending Your Session 

To find out more about Windows XP, begin by learning about the Windows Desktop. 
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The Windows Desktop 
Using Windows XP is simple.  First, you'll notice the large area on the screen, called the Windows Desktop, and 
the narrow band at the bottom, called the Taskbar.  Everything you can do on your computer appears inside 
frames that are called windows. 

 

You can open as many windows at one time as you like—and resize them, move them around, or stack them in 
any order. 
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Icons 
The small pictures on the Windows Desktop are called icons.  Think of them as doorways to the files and 
programs stored on your computer.  Place your mouse over an icon.  Text appears identifying its name or 
contents.  To open the file or program, double-click the icon. 

 

One of the most common icons that you will find on your Windows Desktop is the Recycle Bin, which is 
where you can send files you wish to delete from your computer. 

Shortcut icons are identified by the small arrow on the lower left corner of the image.  These let you access: 

• Programs 

• Files 

• Folders 

• Disk drives 

• Web pages 

• Printers 

• Other computers 
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Taskbar 
Every time you open a window, a button representing it appears on the Taskbar.  The button disappears when 
you close a window. 

 

The Taskbar also contains the Start Menu and notification area, where you'll see the clock.  Other icons in the 
notification area can appear temporarily, showing the status of ongoing activities.  For instance, the printer icon 
appears when you send a file to the printer, and disappears when printing is complete.  You'll also be reminded in 
the notification area when new Windows XP updates are available to download from the Microsoft Web site. 

Windows XP keeps the Taskbar tidy by consolidating buttons when too many accumulate.  For example, 
buttons representing individual email messages are automatically grouped under a single email button.  Clicking 
the button lets you select a specific mail message from a convenient menu. 
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Start Menu 
The Start Menu contains everything you need to begin using Windows XP. 

 

You can return to the Start Menu anytime by clicking the Start button on the Taskbar.  From the Start Menu, 
you can do the following: 

• Start programs. 

• Open files. 

• Customize your system with the Control Panel. 

• Get help by clicking Help and Support. 

• Search for items on your computer or the Internet by clicking Search. 

• And more! 

Some commands on the Start Menu have a right-facing arrow, which means additional choices are available on a 
secondary menu.  Place your pointer over an item with an arrow and another menu appears. 

The left side of the Start Menu updates with links to the programs you use most frequently.  At the top left are 
fixed or "pinned" items—shortcuts to things like your Internet browser and email program. 
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Files and Folders 
Each piece of work, or file, can be stored in a folder. 

 

Windows XP makes it easy to store files in the places that make the most sense.  Place text, image, and music files 
in the folders titled My Documents, My Pictures, and My Music.  Those folders are all easy to find on the 
right side of the Start Menu, and they offer convenient links to the tasks you'll perform most often. 
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Windows 
Windows—frames within the Windows Desktop—display the contents of files and programs.  Working with 
windows is easy when you know the basics. 

 

The name of each window appears at the top, in a title bar. 

Move a window by dragging it.  Click the title bar and, while holding down the mouse button, move the mouse 
pointer across the computer screen. 

Shrink a window by clicking the Minimize button, located at the right-hand side of the title bar. This reduces the 
window to a button on the Taskbar. 

Maximize a window by clicking the Maximize button, located to the right of the Minimize button.  This 
enlarges the window to fill the desktop.  Click the button again to restore the window to its original size. 

Inside a window, browse the menus to see the different commands and tools you can use.  When you find the 
command you want, just click it. 
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Control Panel 
Customizing your computer settings in Windows XP is simple with the Control Panel.  Open it by clicking 
Control Panel on the Start Menu. 

 

From the Control Panel you can complete the following: 

• Change the way Windows XP looks and acts. 

• Add and remove programs or hardware devices. 

• Set up network connections and user accounts. 

• And more! 
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Ending Your Session 
When you want to interrupt your Windows XP session and let someone else use the computer, go to the Start 
Menu. Click Log Off and then Switch User.  Windows XP then will be ready to welcome a different user. 

 

When everyone's finished, go to the Start Menu and click Turn Off Computer.  The next time you log on, the 
Welcome screen will be the first thing you'll see.  Just click your name, type your password, and you'll be back at 
the Windows Desktop. 
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Hardware Troubleshooting Tips 
At times you may encounter a piece of hardware that is not functioning properly.  For such instances, the 
following troubleshooting tips are available: 

• Keyboard Malfunction 

• Mouse Malfunction 

• Monitor Malfunction 

• Printer Paper Jam 
 
 

Complete the Following Steps to Troubleshoot a Malfunctioning Keyboard: 

If your keyboard is not functioning properly, complete the following instructions to correct the issue. 

487. Shutdown your computer. 

488. Unplug and reconnect the keyboard cable. 

489. Verify that all other cables connected to the back of the computer and secure. 

490. Reboot your computer. 

491. If the keyboard is still not functioning properly, contact your technical support group. 
 
 

Complete the Following Steps to Troubleshoot a Malfunctioning Mouse: 

If your mouse is not functioning properly, complete the following instructions to correct the issue. 

492. Shutdown your computer. 

493. Unplug and reconnect the mouse cable. 

494. Verify that all other cables connected to the back of the computer and secure. 

495. Reboot your computer. 

496. If the mouse is still not functioning properly, contact your technical support group. 
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Complete the Following Steps to Troubleshoot a Malfunctioning Monitor: 

If your monitor is not functioning properly, complete the following instructions to correct the issue. 

497. Verify that the power light on the front of the monitor is lit. 

498. If the power light on the front of the monitor is not lit, press the button to turn on the monitor. 

499. If the power light on the front of the monitor is lit and the monitor is still not working, shutdown your 
computer. 

500. Unplug and reconnect the monitor cable to the back of the computer. 

501. Unplug and reconnect the monitor cable to the back of the  monitor. 

502. Verify that all other cables connected to the back of the computer and secure. 

503. Reboot your computer. 

504. If the monitor is still not functioning properly, contact your technical support group. 
 
 

Complete the Following Steps to Troubleshoot a Printer Paper Jam: 

If paper is jammed in the printer, complete the following instructions to correct the issue. 

505. If you can see paper partially printed in the paper tray on top of the printer, carefully remove it from the 
roller. 

506. Remove the paper tray(s) and remove any paper that has become lodged in the printer or that has 
become crumpled in the paper trays.  You may need to run your hand along the top of the tray area to feel 
for any paper that has become lodged. 

507. Open the front cover of the printer and remove the toner cartridge.  If you find any paper here, 
carefully remove it from this area.  Carefully replace the toner cartridge and close the cover. 

508. Open the back cover of the printer (if applicable to your printer type) and remove any paper found in 
this area.  Close the cover when complete. 

509. Replace the paper tray(s).  If you have removed more than one tray, ensure that you replace all of the 
trays that were removed back in their proper location.  Once all of the paper trays are replaced, the printer 
will perform a self-test to verify that all paper has been removed.  

510. If the printer is still not functioning properly, contact your technical support group. 
 



 

Glossary 
A 

Account: n., A statement of monetary activities over a time period; a record of debit and credit entries to cover 
transactions involving a particular item, person, or concern. 

Accounting Period: n., The time period reflected by a set of financial statements, usually twelve consecutive months. 

Action Date: n., A time limit assigned to an event or activity. An event or activity that has not been completed by its 
assigned action date is considered overdue. 

Adjunct Income Eligibility: n., Eligibility granted to persons who document participation in a Gateway Program and 
certain members of their families. 

Adjusted Gross Income: n., Gross income from taxable sources minus the maximum allowable adjustments. 

Administer: v., To have charge of; to manage. 

Administrate: v., To administer. 

Administrative Appeal: n., An appeal through which a local WIC Agency, potential local WIC Agency, authorized WIC 
vendor, or potential authorized WIC vendor may appeal an adverse action of the local WIC Program. 

Administrator: n., A person having administrative or managerial authority in an organization. 

AFDC: See "Aid to Families with Dependent Children." 

Affidavit: n., A written declaration made under oath before a notary public or other authorized officer; A form that allows 
certain persons who are exempt from documentation requirements by federal regulations to self-declare income, 
identification, and/or residency. 

Agency: (1) n., An administrative division of a government or international body; a tribal, state, or local Agency. (2) See 
"WIC Agency." 

Agent: n., A person or concern authorized to act for another; an agent or substitute. 

AGI: See "Adjusted Gross Income." 

Aid to Families with Dependent Children: n., A social welfare program that is now referred to as the Temporary 
Assistance to Needy Families (TANF) program. 

Alt key: See "Alternate Key." 

Alternate key: n., A key on a computer keyboard that, when depressed, changes the effect of a concurrently depressed 
key to execute an alternate operation, or changes the effect of pressing a button on a pointing device (clicking). 

American Indian or Alaskan Native: n., A person having origins in any of the original peoples of North America who 
maintains cultural identification through tribal affiliation or community recognition (includes Aleuts and 
Eskimos). 

Antibody: n., A protein found in blood that is produced by the body in response to specific antigens. 

Antigen: n., A substance that when introduced into the body stimulates the production of an antibody. Antigens include 
toxins, bacteria, foreign blood cells, and the cells of transplanted organs. 

Apgar Score: n., A system of assessing the general physical condition of a newborn infant. The Apgar Score rates the 
baby's heart rate, respiration, muscle tone, skin color, and response to stimuli immediately after birth and again 
five minutes later. Each time the infant is assessed, the five criteria are evaluated and assigned a value of 0, 1, or 
2. The five scores are then added together to produce the final score, with a perfect score being 10. 

Appeal: (1) n., An earnest or urgent request, entreaty, or supplication. (2) n., An application to a higher authority, as for 
sanction or a decision. (3) v., To make application to a higher authority, as for a case review when approval for 
participation in the local WIC program has been denied. 
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Applicant: n., A person or concern that is applying for participation in the local WIC program. 

Application: (1) n., A request, as for assistance, employment, or admission to a school or program. (2) n., A computer 
program with a user interface. 

Application Date: n., The date on which an applicant contacts a local Agency to make an oral or written request for WIC 
benefits; The date on which an applicant is referred to the local WIC program. 

Appointed Representative: n., A person or concern authorized to act for another; an agent or substitute. 

Approved Foods: n., Those specific foods which WIC program administrators, using USDA standards, have approved 
for the current year for participants to receive in exchange for WIC vouchers (food instruments or checks. 

Asian or Pacific Islander: n., A person having origins in any of the original peoples of the Far East, Southeast Asia, the 
Indian Subcontinent, or the Pacific Islands. This area includes, for example, China, Indonesia, Japan, Korea, the 
Philippine Islands, Samoa, and Vietnam. 

Audit: n., A formal examination of a person or a concern's business practices, records, or financial accounts to check their 
correctness. 

Authentication: n., The process of identifying a person and verifying his or her eligibility to access information or specific 
areas of a physical or logical structure. 

Authorization: n., The approving of an action, especially when done by one in authority. 

Authorized Agent: n., A person or concern authorized to act for another; an agent or substitute. 

Authorized Representative: n., A person or concern authorized to act for another; an agent or substitute. 

Authorized Store Representative: n., An owner, manager, assistant manager, head cashier, or chief fiscal officer; A 
person to act for the store; an agent. 

Authorized WIC Vendor: n., A food retailer or freestanding pharmacy that has executed a currently effective WIC 
Vendor Agreement. 

B 
Backspace key: v., A key on a computer keyboard that is used to delete the character immediately to the left of the 

cursor's position, moving all following characters one position to the left. 

Bar Code: n., A parallel series of vertical bars of varying widths, in which each of the digits zero through nine are 
represented by a different pattern of bars that can be read by a laser scanner. The bars are commonly found on 
consumer products and are used especially for inventory control. 

Base Participant: n., The member of a WIC household around whom the household's food instrument issuance and 
pick-up cycle is based. The WIC participant who has participated in the WIC program for the longest continuous 
period is the default base participant. If the period of participation cannot be determined for any household 
member, the oldest child or infant is the default base participant. 

Basic Food Package: See "Default Food Package." 

BF Notes: n., Breastfeeding Notes. 

Black (not of Hispanic origin): n., A person having origins in any of the original dark-complected racial groups of 
Africa. 

BMI: See "Body Mass Index." 

Body Mass Index: n., A measure of body fat based on height and weight that applies to both adult men and women. 

Boot: v., To start a computer by loading an operating system. A set of built-in instructions, often referred to as a 
bootstrap loader, is automatically processed when the computer is turned on. These instructions direct the 
computer to search for an operating system, load it into memory, and pass control to it. The term, "boot," is 
derived from the word, "bootstrap." Just as bootstraps help you pull your boots on so that you can go for a hike, 
a bootstrap loader helps a computer load its operating system so that it can process user software. 

Breastfeeding: (1) n., The practice of feeding (a baby) mother's milk from the breast. (2) n., A WIC category; a 
postpartum woman who is breastfeeding her infant(s) up to one year after birth. 
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Browser: See "Web Browser." 

C 
C-section: See "Cesarean Section." 

Caretaker: n., A person who is legally responsible for the person or property of another considered by law to be 
incompetent to manage his or her affairs. For example, in the case of a child, the caretaker is the person who is 
the legal guardian of the child or the child's mother. 

Case Manager: n., A person who manages and coordinates client needs. 

Caseload: n., The number of WIC applicants and participants assigned to a Local Agency/Clinic. 

Categorical Eligibility: n., The state of being eligible for participation in the WIC program based on categorical 
guidelines. To be considered Categorically Eligible, a WIC applicant must be: a pregnant woman, a non-
breastfeeding woman up to six months postpartum, a breastfeeding woman up to one year postpartum, an infant 
under one year of age, or a child up to his or her fifth birthday. 

CBT: See "Computer Based Training." 

CDC: See "Centers for Disease Control and Prevention." 

Census Tract: n., A particular community defined for the purpose of taking a census. Most often, these coincide with the 
limits of cities, towns, and townships. In unincorporated areas these are often arbitrary, except for coinciding 
with county lines. Also known as a census area or a census district. 

Centers for Disease Control and Prevention: n., The federal Agency responsible for administering national programs 
for the prevention and control of communicable and vector-borne diseases and for developing and implementing 
programs for dealing with environmental health problems. It also directs quarantine activities and conducts 
epidemiological research, and it provides consultation on an international basis for the control of preventable 
diseases. 

Central Processing Site: n., A location that collects, maintains, summarizes, and reports on local WIC program data for a 
state or tribal Agency. 

Certification: n., The process by which applicants are determined by a CPA to be eligible to receive WIC benefits. The 
applicant is checked for category, residence, income, and nutritional need. The first time an applicant is certified 
is known as the Initial Certification. The re-certification of participants at regular intervals is known as a 
Subsequent Certification or "sub-cert." 

Certification Date: n., The date on which a WIC applicant or participant is certified for participation in the WIC 
program. From the date of Certification, the WIC participant is eligible to receive checks, nutrition education, 
and food instruments. 

Certification End Date: n., The last day of a WIC participant's Certification period. 

Certification Expiration Date: See "Certification End Date." 

Certification Period: n., The amount of time during which a WIC participant has been approved to receive benefits. 

Cesarean Section: n., Childbirth by surgical removal of the fetus through an incision made in the wall of the abdomen 
and in the uterus. 

Chain Store: n., A store that is owned or operated by a corporation, partnership, cooperative association, or other 
business entity that has 20 or more stores owned or operated by the business entity. 

Check: See "Food Instrument." 

Check Box: n., A GUI control; A square box that is selected or cleared to turn an option on or off. More than one check 
box in a group can be selected. 

Child: (1) n., A person between birth and puberty. (2) n., A WIC category; a person who has reached his or her first 
birthday but has not yet reached his or her fifth birthday. 

Children with Special Health Care Needs: n., A social welfare program that provides and promotes family-centered, 
community-based, culturally-competent, coordinated care for children with special health care needs and their 
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families. Children with special health care needs may have many professionals invested in their physical and 
emotional well-being. A function of the program is to coordinate the care of these children to assure 
communication and planning amongst team members, including family, primary health care practitioners, 
specialists, community programs and insurance plans. 

Chronic: adj., marked by long duration or frequent recurrence. 

Click: v., To press down and release the left (or only) button on a pointing device, such as a mouse, while the pointer is 
positioned over an object in a GUI environment. The left (or only) button on a pointing device is used for a 
primary function, while a right mouse button is typically assigned an ancillary function. For example, clicking 
selects an object or activates a command or a function. 

Client: n., A WIC applicant or participant. 

Client Machine: n., A user's workstation that is attached to a network. 

Clinic: (1) n., A meeting for diagnosis of problems, and instruction or remedial work in a particular activity. (2) n., A 
healthcare facility or medical establishment run by a group of medical specialists. (3) See "WIC Clinic." 

Clinic of Operation: n., The WIC Clinic at which a user is currently working, or the WIC Clinic to which WIC Clients 
currently being served by a user are assigned. 

Commodity: (1) n., A product or products bought and sold in commerce. (2) n., A base food category; a collection of 
food items in specified quantities. 

Commodity Supplemental Food Program: n., A U.S. Department of Agriculture supplemental food program for low 
income pregnant, breastfeeding, and postpartum non-breastfeeding women (up to one year after the birth of the 
child), their infants and children (up to age six), and senior citizens sixty years of age and older. 

Competent Professional Authority: n., A professional WIC staff member who provides final approval for WIC 
eligibility. For example, a CPA may be a Physician (M.D. or D.O.), a Registered Dietitian (R.D.), a Licensed 
Dietitian (L.D.), a Nutritionist, a dietetic technician registered (DTR), a registered nurse (RN); a licensed 
vocational nurse (LVN); a physician's assistant (PA), or other degreed professional with a background in food 
and nutrition. 

Compliance Buy: n., A covert, on-site investigation in which a WIC program representative poses as a WIC participant 
and redeems one or more food vouchers or checks. The purpose of such an investigation is to ensure that WIC 
vendors comply with the vendor agreement and/or policies. The investigation may last for several days and 
concludes after three separate visits to the vendor have been completed or after sufficient cause has been found 
to disqualify the vendor. 

Compliance Monitoring: n., The investigation of WIC vendors to ensure that they adhere to WIC regulations. 
Compliance monitoring may include compliance buys, routine monitoring visits, and vendor record reviews. 

Computer: n., A general-purpose machine that processes data according to a set of instructions that are stored internally 
either temporarily or permanently. 

Computer Based Training: n., Training program (computer program) that individual users can access from their 
workstations to provide remedial or advanced instruction in certain tasks and areas of knowledge. 

Concern: n., A business establishment or enterprise; a firm. 

Confidential: adj., Of or being information available only to authorized persons. 

Contact: (1) n., A person who might be of use; a connection. (2) n., A person who can be contacted for matters related to 
the WIC program. 

Contract Formula: n., Infant formula products that are listed in a current rebate contract. 

Control key: n., A key on a computer keyboard that, when depressed, changes the effect of a concurrently depressed key 
to activate a command, or changes the effect of pushing a button on a pointing device (clicking). 

Cooperative: n., A concern that is owned or managed jointly by those who use its facilities or services. 

Corporation: n., A concern that is granted a charter recognizing it as a separate legal entity having its own rights, 
privileges, and liabilities distinct from those of its members. 

CPA: See "Competent Professional Authority." 
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Criterion: n., pl. Criteria, A standard on which a judgment can be based. 

CSFP: See "Commodity Supplemental Food Program." 

CSHCN: See "Children with Special Health Care Needs." 

Ctrl key: See "Control Key." 

Cursor: n., A symbol used in a GUI to point to on-screen elements. On DOS and other character-based screens, it is a 
blinking rectangle or underline. On Windows and other graphics-based screens, it is also called a "pointer," and it 
changes shape as it is moved into different windows. For example, it may turn into an I-beam for editing text, an 
arrow for selecting menus or a pen for drawing. Also See "Pointer." 

Cursor keys: n., The keys on a computer keyboard that are used to move the pointer (or cursor) on screen. They include 
the Up-arrow, Down-arrow, Left-arrow, Right-arrow, Home, End, Page Up and Page Down keys. 

Custody: n., The function of watching, guarding, or overseeing, as in the guardianship of a child. 

D 
Day: n., A calendar day. All references to a, "day," or, "days," in the WIC documentation refer to calendar days, unless 

otherwise indicated, not working days. 

Default: n., A particular setting or value for a user interface control that is assigned by the computer program and remains 
in effect unless canceled or overridden by the user. 

Default Food Package: n., A food package specific to a participant's WIC category and nutritional needs (nutritional risk 
factors). 

Default Printer: n., A printer that has been specified through the application's System Tools as the output device for a 
particular type of print job (checks, reports, or documents). 

Delete key: n,. A key on a computer keyboard that is used to delete the character immediately to the right of the cursor's 
position, moving all following characters one position to the left. 

Dietary Intake: n., A person's food consumption over a given period. Usually stated in terms of nutritional units and 
broken down into food groups or categories. 

Disqualify: (1) v., To render unqualified or unfit. (2) v., To declare unqualified or ineligible. A WIC vendor may be 
disqualified for participation in the local WIC program if the vendor accumulates enough unresolved violations 
or commits a major violation for which disqualification is the required action. 

Double-click: v., To press down and release a button on a pointing device, such as a mouse, twice in rapid succession 
while the pointer is positioned over an object in a GUI environment. Double-clicking activates a command or a 
function. 

Dual Participation: n., A WIC program abuse; The act of receiving more WIC benefits than one is entitled to through 
dual enrollment and dual Certification in the WIC program. 

E 
E.P.: n., The abbreviation of, "Erythrocyte Protoporphyrin," which is measured in blood tests as an indicator of iron 

deficiency. 

EBT: See "Electronic Benefit Transfer." 

EBT Card: n., Electronic Benefit Transfer (EBT) card; a debit card used to distribute government benefits nationwide. 
Welfare program participants (especially food stamp recipients) use an EBT card to shop for eligible food items 
at stores authorized by the U.S. Department of Agriculture (USDA). Participants swipe their EBT card through a 
Point-of-Sale (POS) card reader and enter a Personal Identification Number (PIN) to secure the transaction. The 
system deducts the exact amount of the purchase from the participant's EBT Account and deposits it into the 
retailer's bank Account. 

Electronic Benefit Transfer: n., An electronic system that allows a recipient to authorize transfer of their government 
benefits from a Federal Account to a retailer Account to pay for products received. EBT systems are currently 

175 



F I N A N C I A L  M A N A G E M E N T  T R A I N I N G  M A N U A L  

being used in many States to issue Food Stamps and other benefits. Over 95 percent of food stamp benefits are 
currently being issued by EBT. 

Eligibility: n., The state of being eligible. 

Eligible: adj., Satisfying certain requirements, as for selection; Qualified for or allowed or worthy of being chosen. 

Enter key: n., A key on a computer keyboard that is used to signal the end of a line of data or the end of a command. In 
word processing, it ends a paragraph or a line of text. In data processing, it signals the end of input for a field. 

Esc key: See "Escape Key." 

Escape key: n., A key on a computer keyboard that is used to exit a mode or cancel a function. 

Expedite: v., To speed up the progress of; to accelerate. 

F 
Fair Hearing: n., A hearing that is granted in extraordinary situations where the normal judicial process would be 

inadequate to secure due process because a person or concern would be harmed or denied their rights before a 
judicial remedy became available (as in loss of welfare benefits); the informal dispute resolution process through 
which a person or concern may appeal a tribal, state, or local Agency action that would result in the person or 
concern's denial of participation or disqualification from participation in the WIC program. 

Farmers Market: n., A public market at which farmers and often other vendors sell produce directly to consumers; an 
open-air marketplace for farm products 

FDPIR: See "Food Distribution Program on Indian Reservations." 

Fetal Growth Restriction: n., A birth weight that is below the tenth percentile for the weight for gestational age. 

FGR: n., See "Fetal Growth Restriction." 

File Server: n., A computer that processes requests for HTML and other documents that are components of web pages. 

Filter: (1) n., A computer program or routine that blocks or allows access to data based on a particular criterion or set of 
criteria. Filters use masks against which all data are compared and only matching data are passed through or 
blocked, hence the concept of a filter. (2) v., To use a filter to block or allow access to data. (3) v., To select data. 

Financial: adj., Of, relating to, or involving finance, finances, or financiers. 

Fiscal Year: n., A twelve-month period for which an a person or concern plans the use of its funds; An Accounting 
Period of twelve months. 

FNS: See "Food and Nutrition Service." 

Food and Nutrition Service: n., An Agency of the United States Department of Agriculture (USDA) that administers 
food security programs, such as the Food Stamp and WIC programs. 

Food Category: n., A general class of food with no specification of brand/type or quantity/size. For example, milk, juice, 
eggs, cheese, cereal, infant cereal, beans, peanut butter, tuna, and carrots are all WIC food categories. 

Food Distribution Item: See "Food Item." 

Food Distribution Program on Indian Reservations: n., A social welfare program that provides commodity foods to 
low-income households, including the elderly, living on Indian reservations, and to Native American families 
residing in designated areas near reservations. 

Food Instrument: (1) n., A voucher, check, electronic benefits transfer card (EBT), coupon, or other document that is 
used to obtain government benefits, as from the WIC program. (2) n., A sub-set of a food package. A grouping 
of food items as they are displayed on a voucher, check, coupon, or other document that is used to obtain 
government benefits 

Food Item: n., A food of a specified brand/type in a specified quantity/size that has been approved for purchase with 
WIC food instruments. Some food items also include special restrictions. For example, Peanut Butter 
(Brand/Type: any brand. Quantity/Size: 18 oz. Jar only. Restrictions: No added marshmallow, chocolate, honey, 
jelly, etc.; No other size or quantity.) 
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Food Package: n., A specific group of WIC approved food items prescribed for the dietary needs of a WIC participant. 
Food packages vary according to a participant's WIC category and nutritional needs (nutritional risk factors). 

Food Prescription: See "Food Package." 

Food Product: n., A food product is a group of identical food items that share the same UPC code. For example, all one-
gallon cartons of milk of a particular brand are considered a single food product. 

Food Stamp: n., A voucher, issued by the government to persons with low incomes, that can be redeemed for food at 
stores. 

Food Stamp Program: n., A program that provides food to low income people living in the United States. Benefits are 
distributed by the individual states but the program is administered through the U.S. Department of Agriculture. 
Most food stamp benefits are now distributed using Electronic Benefit Transfer (EBT) cards but for most of its 
history, the program has used paper vouchers (food stamps) of some kind. 

Food Voucher: n., Documentation showing the "prescribed" food package issued to each WIC participant. These 
vouchers are traded by the client at authorized stores in exchange for the approved foods specified on the 
vouchers. 

Formula: n., A liquid food for infants, containing most of the nutrients in human milk. 

Fraud: n., A deception deliberately practiced in order to secure unfair or unlawful gain. 

Freestanding Pharmacy: n., A pharmacy that does not operate within another retail store. Freestanding pharmacy 
includes freestanding pharmacies that are chain stores and freestanding pharmacies participating under a WIC 
corporate agreement. 

FSP: See "Food Stamp Program." 

Function keys: n., The keys on a computer keyboard that are used to command the computer (F1, F2, etc.), activating a 
function within a given application when pressed, either alone or in combination with the Alt, Shift, and Control 
keys. F1 is commonly used as the help key, but the purpose of any function key is determined by the software 
application that is active. 

FY: See "Fiscal Year." 

G 
Gateway Program: n., A program, such as Food Stamps, Medicaid, and Temporary Assistance to Needy Families 

(TANF), that serves applicants with income levels that are equal to or lower than WIC eligibility guidelines for 
income. Thus, any WIC applicant who is already in a gateway program automatically meets income eligibility for 
WIC. 

Gestation: (1) n., The period of fetal development in the uterus from conception until birth; pregnancy. (2) n., The 
condition of carrying a developing fetus within the uterus: gravidity, gravidness, pregnancy. 

Graphical User Interface: n., A user interface for a computer based on graphics (icons and pictures and menus) instead 
of text; uses a pointing device as well as a keyboard for user input. Typical "objects" or "controls" found in a 
graphical user interface (GUI) are menus, buttons, check boxes, list boxes, text boxes, and so on. Users can 
interact with or select most objects in a GUI environment through the use of a pointing device. 

Gravid: adj., Carrying a developing fetus within the uterus. 

Gravidity: n., The condition of carrying a developing fetus within the uterus. 

Gravidness: See "Gravidity." 

Growth Grid: n., A line chart used to plot a person's growth. For example, a growth grid may plot a person's height or 
weight over a period, or it may plot a person's height against the person's weight. Regardless of what a growth 
grid tracks, every grid includes a plot line, allowing the comparison of the person's growth statistics with the 
current standards for growth, set by the CDC. 

Guardian: n., One who is legally responsible for the care and management of the person or property of an incompetent 
or a minor. 

GUI: See "Graphical User Interface." 
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H 
Hardware: n., A computer and all equipment attached to it. 

Health District: n., A grouping of cities and / or counties that provide public health services in a geographic location. 

Hematocrit: n., The proportion, by volume, of the blood that consists of red blood cells. The hematocrit (hct) is 
expressed as a percentage. For example, a hematocrit of 25% means that there are 25 milliliters of red blood cells 
in 100 milliliters of blood. 

Hemoglobin: n., The protein molecule in red blood cells which carries oxygen from the lungs to the body's tissues and 
returns carbon dioxide from the tissues to the lungs. The hemoglobin level is expressed as the amount of 
hemoglobin in grams (gm) per deciliter (dl) of whole blood, a deciliter being 100 milliliters. 

High-risk: adj., (1) Of, relating to, or characterized by risk. (2) Being subject to a potential danger or hazard, especially 
due to nutritional or health issues. 

Hispanic: n., A person of Mexican, Puerto Rican, Cuban, Central or South American, or other Spanish culture or origin 
regardless of race. 

Homeless: (1) adj., Having no home. (2) n., People without homes considered as a group. 

Homeless Facility: n., A publicly or privately supervised shelter designed to provide a temporary residence (not more 
than 365 days); a temporary residence facility for individuals intended to be institutionalized; or a public / private 
place not designed for, or normally used as, a regular sleeping accommodation for humans. 

Household: n., A group of related or non-related individuals, who usually, although not necessarily, are living together 
and share income. A WIC household is a logical grouping of WIC participants who live at the same address. 

HTML: See "Hypertext Markup Language." 

HTTP: See "Hypertext Transport Protocol." 

Hyperlink: n., A segment of text or a graphical item in a hypertext document that serves as a cross-reference between 
parts of the same document or between that document and another hypertext document. 

Hypertext: n., A computer-based text retrieval system that enables a user to access specified locations within web pages 
or other electronic documents by clicking hyperlinks within other web pages or electronic documents. 

Hypertext Markup Language: n., A markup language used to format text and multimedia objects (as in a web page) for 
display in a web browser, best known for its use of hypertext to link information internally within the same 
document or externally to other documents. 

Hypertext Transport Protocol: n., The communications protocol used to connect to servers on the World Wide Web. 
Its primary function is to establish a connection between a client computer and a Web server and transmit web 
pages from the server to a web browser or other HTTP application on the client computer. 

I 
Immunity: n., Resistance to infection by a specific pathogen. 

Immunization: n., The process of inducing immunity, usually through inoculation or vaccination. 

Income: n., The amount of money received during a period of time in exchange for labor or services, from the sale of 
goods or property, or as a profit from financial investments. 

Income Eligibility: n., The state of being eligible for participation in the WIC program based on income guidelines. To 
be considered Income Eligible, the household income of a WIC applicant must be at or below 185 percent of the 
Poverty Income Guidelines. An applicant who participates or who has certain family members who participate in 
a gateway program are adjunctively income eligible, that is, they are deemed to meet the income eligibility criteria 
automatically. 

Indigent: adj., Experiencing want or need; Having little or no money or wealth. 

Ineligible: adj., (1) Disqualified by law, rule, or provision. (2) Unworthy of being chosen. 
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Infant: n., (1) A child in the earliest period of life. (2) A WIC category; a person who has been born but has not reached 
his or her first birthday. 

Inoculation: n., The introduction of an antigen into the body, usually by injection, in order to stimulate the production of 
antibodies to produce immunity to an infectious disease. 

Internet: n., An interconnected system of networks connecting computers around the world through the TCP/IP 
protocol. 

Intrauterine Growth Restriction: n., Also known as Intrauterine Growth Retardation, both terms are now obsolete and 
have been replaced with the term Fetal Growth Restriction. 

IUGR: See "Intrauterine Growth Restriction." 

K 
Keyboard: n., A set of input keys attached to computer. It resembles a standard typewriter with the addition of following 

specialized keys: Alternate, Backspace, Control, Cursor, Delete, Enter, Escape, Function, Shift, and Tab. NOTE: 
Most computer keys repeat when held down, a phenomenon first-time computer users must get used to. If you 
hold a key down that is used to command the computer, you'll be entering the command several times. 

Kosher: adj., Conforming to Jewish dietary laws; ritually pure 

Kosher Food: n., Food that conforms to strict Jewish biblical laws pertaining not only to the type of food that may be 
eaten, but to the kinds of food that can be combined at one meal (for example, meat and dairy products may not 
be mixed). In order to meet kosher standards and receive the kosher seal, food must be prepared under a rabbi's 
supervision. In addition to the kinds of animals considered kosher, the laws also decree that animals be fed 
organically grown food and killed in the most humane manner possible. The word kosher is a derivation of the 
Hebrew kasher, meaning proper or pure. 

L 
Legal Guardian: n., A person who has been appointed by a court of law or Department of Social Services, or other legal 

means, to have primary, physical custody of a minor. A legal guardian shall be authorized to provide eligibility 
information for an applicant, consent to medical treatment of the applicant, and shall be held legally bound if 
sanctions are imposed. 

Licensed Health Care Professional: n., Someone authorized to write medical prescriptions under in accordance with 
State Law. 

List Box: n., A GUI control; Any type of box that contains a list of items that can be selected. Text cannot be typed into a 
list box. 

LMP: n., Last Menstrual Period 

Local: (1) adj., Relating to or applicable to or concerned with the administration of a small geographic region--town, city, 
or district--rather than a larger area. (2) adj., Of or belonging to or characteristic of a particular locality or 
neighborhood. 

Local Agency: n., The agency in which one is located. 

Local Clinic: n., The clinic in which one is located. 

M 
Mandate: v., To make mandatory or required, especially by law. 

Medicaid: n., A joint federal and state program that helps low-income individuals or families pay for the costs associated 
with long-term medical and custodial care, provided they qualify. Although largely funded by the federal 
government, Medicaid is run by the state where coverage may vary. 

Medical Home: n., Not just a building, house, or hospital, but a team approach to providing health care. A Medical 
Home originates in a primary health care setting that is family-centered and compassionate. A partnership 
develops between the family and the primary health care practitioner. Together they access all medical and non-
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medical services needed by the child and family to achieve maximum potential. The Medical Home maintains a 
centralized, comprehensive record of all health related services to promote continuity of care. 

Medicare: n., A program of health insurance for the elderly and disabled. Medicare has two parts: Part A (Hospital 
Insurance), and Part B (Medicare Insurance, helps cover doctors' services, outpatient hospital care, and some 
other medical services that Part A does not cover). Part A is paid from the U.S. Government's general fund. Part 
B is paid for by the general fund and by contributions from the covered persons by way of a deduction from 
their monthly social security check. 

Migrant Farm Worker: n., A person whose primary employment is in agriculture on a seasonal basis, who has been so 
employed within the last 24 months, and who establishes, for the purpose of such employment, a temporary 
residence. 

Monitor: n,. A display screen used to present output from a computer or other video device. 

N 
Neonatal: adj., Of or relating to the first 28 days of an infant's life. 

Net: See "Network." 

Net Income: n., A person or concern's total earnings, reflecting revenues adjusted for costs of doing business, 
depreciation, interest, taxes, and other expenses. 

Network: n., A system of computers interconnected by telephone wires or other means in order to share information. 

No-show: n., A person who fails to appear for a scheduled appointment, pick-up his or her WIC food instrument checks, 
or attend a nutrition education class. 

Non-breastfeeding: n., A WIC category; a postpartum woman who is not breastfeeding her infant(s) up to six months 
after birth. 

Non-contract Formula: n., Infant formula products that are listed in a current rebate contract. 

Nutrition: n., The science or study that deals with food and nourishment, especially in humans. 

Nutrition Education: n., Individual or group education classes, nutrition information, and educational materials designed 
to improve health status, achieve positive change in dietary and physical activity habits, and emphasize 
relationships between nutrition, physical activity, and health, all in keeping with the personal and cultural 
preferences of the individual. 

Nutrition Risk Eligibility: n., The state of being eligible for participation in the WIC program based on nutrition risk 
guidelines. To be considered Nutrition Risk Eligible, a WIC applicant must be at nutrition risk, as determined by 
a health professional. Federal regulations recognize five major types of nutrition risk for WIC eligibility: Type 1- 
anthropometric risk (e.g., underweight or overweight); Type 2- biochemical risk (e.g., low hemoglobin or low 
hematocrit); Type 3- medical risk (e.g., diabetes mellitus); Type 4- dietary risk (e.g., failure to heed Dietary 
Guidelines for Americans recommendations); and Type 5- predisposing factors (e.g., homelessness). 

Nutritional Risk: (1) n., Detrimental / abnormal nutritional conditions detectable by bio-chemical or anthropometric 
measurements. (2) n., Other documented nutritionally related medical conditions. (3) n., Dietary deficiencies that 
impair or endanger health. (4) n., Conditions that predispose persons to inadequate nutritional patterns or 
nutritionally related medical conditions. 

Nutritionist: n., One who is trained or an expert in the field of nutrition. 

O 
Operating System: n., The master control program that runs a computer. The operating system (OS) is the first software 

loaded when a computer is turned on. The core of the OS, the "kernel," resides in memory at all times while the 
computer is operational. The OS allows access to and control of all software applications available on the 
computer. Software applications "talk to" the operating system for all user and hardware interface operations. 

OS: See "Operating System." 

180 



G L O S S A R Y  

P 
PAN: See "Primary Account Number." 

Participant: n., A client or customer of the WIC program; one who participates in the WIC program; one who receives 
WIC benefits. 

Participant Termination: n., The act of terminating a participant. When a participant is terminated, the participant can 
no longer receive WIC benefits. The following is a list of some of the reasons for which a participant may be 
terminated: a data entry error; categorical ineligibility; income ineligibility; residence ineligibility; nutritional risk 
ineligibility; Certification period expired; participant no longer wants benefits; he or she is placed on the waiting 
list; he or she abuses the program; he or she is deceased; he or she fails to pick up food instrument checks for 
two consecutive months; he or she has a priority for which there is a freeze on enrollment; he or she is in a 
category for which there is a freeze on enrollment. A participant must be recertified for participation after being 
terminated. 

Partnership: n., A legal contract entered into by two or more persons in which each agrees to furnish a part of the capital 
and labor for a business enterprise, and by which each shares a fixed proportion of profits and losses. 

Password: (1) n., A secret word or phrase that one uses to gain admittance or access to information. (2) n., A sequence of 
characters that one must type to gain access to a file, an application, or a computer system. 

PC Card: n., Portable Computer Cards (PC cards) are credit-card sized, removable peripherals for portable computers. 
Portable computers have always been limited in features due to their size, and the PC card provided a means to 
expand their functionality. PC cards were introduced and standardized in 1990 by PCMCIA, which is why PC 
cards are sometimes referred to as "PCMCIA cards." The functionality available through such cards includes 
flash memory, hard disk, network, modem, sound, and SCSI disk control. 

PCMCIA: See "Personal Computer Memory Card Industry Association." 

PDF: See "Portable Document Format." 

Peer Group: (1) n., A group of people or concerns that share certain characteristics. (2) n., A group of vendors that share 
a similar size, location, or client population. 

Personal Computer Memory Card Industry Association: n., An international standards body and trade association 
that was founded in 1989 to establish a standard for connecting peripherals to portable computers. PCMCIA 
created the PC card which is also referred to as a "PCMCIA card". The organization changed its name to PC 
Card Industry Association in March 1995 to reflect the wide range of peripheral devices (modems, software, 
games) that can be used in slots on computers. The smart card industry refers to PC Cards as machine cards and 
smart cards as people cards. 

Personal Identification Number: n., A number chosen and reserved by a user to access EBT or EFT programs. A PIN 
is usually associated with card-based technology use. Once a card has been swiped at a point-of-sale, the user 
enters a PIN on the terminal in order to verify his/ her use. 

PIN: See "Personal Identification Number." 

Point-Of-Sale: n., A business or concern at which a product or service can be obtained. The systems used to capture 
transaction data at a points of sale are complex. Point of sale systems use computers or specialized terminals that 
incorporate cash registers, bar code readers, optical scanners, and magnetic stripe readers to accurately capture all 
pertinent data associated with the transaction instantaneously. 

Pointer: n., A symbol used in a GUI to point to on-screen elements. Also See "Cursor." 

Pointing Device: n., A computer input device used to move a pointer (or cursor) around in a GUI environment. The 
movement of a pointer observed on a computer monitor is relative to the movement of the pointing device that 
controls it. Pointing devices used today include the mouse, touchpad, pointing stick, joystick, trackball, and 
tablet. The main pointing device for desktop computers is the mouse, while the main pointing devices for laptop 
computers are the pointing stick and the touchpad. 

Portable Document Format: n., The file format used in Adobe's Acrobat document exchange technology. 
Acrobat/PDF is used for document exchange and publishing on the Web. Documents of this type can be 
downloaded and read independently of web pages. 

POS: See "Point-of-Sale." 
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POS Terminal: n., An electronic transaction terminal used in an electronic Point-Of-Sale (POS) system. The terminal 
interacts with databases to approve transactions and transmits sales information for posting against customer 
accounts. There are two basic types of POS terminals: electronic cash registers that are used by high volume 
merchants, such as department stores, and dial-up terminals that automatically dial a special telephone number, 
often a toll-free number, to obtain authorization. 

Postpartum: (1) adj., Of or occurring in the period shortly after childbirth. (2) n., A woman whose pregnancy has ended 
within the last six to twelve months, categorized as Non-breastfeeding or Breastfeeding for the purposes of the 
WIC program. 

Pregnancy: (1) n., The condition of carrying a developing fetus within the uterus. (2) n., An instance of carrying a 
developing fetus within the uterus. (3) n., The period during which one carries a developing fetus within the 
uterus. 

Pregnant: (1) adj., Carrying developing offspring within the body. (2) n., A WIC category: A woman carrying one or more 
embryos or fetuses in her womb. 

Premature: adj., (1) Developing, occurring, or existing before the usual, correct, or expected time. (2) (of childbirth) born 
before the end of the normal period of gestation, especially, in human infants, before a period of 37 weeks. 

Prenatal: adj., Existing or occurring before birth; The period between conception and birth. 

Prescreening: (1) v., To examine or interview before further selection processes occur. (2) n., The process of gathering 
basic information about a WIC program applicant to determine whether he or she satisfies Categorical and 
Income Eligibility requirements. 

Prescription: n., A written order, especially by a physician, for the preparation and administration of a treatment for a 
health condition. 

Presumptive Eligibility: n., The state of being eligible pending proof of participation in a qualifying Gateway Program or 
proof of income that falls within Income Eligibility guidelines. 

Presumptive Income Eligibility: n., Temporary eligibility granted to persons who have claimed participation in a 
Gateway Program or claimed income that falls within Income Eligibility guidelines without presenting proof of 
such participation or income. Such eligibility is also extended to certain members of the persons' families. 

Primary Account Number: n., A number used to identify an account into which funds are electronically deposited. 

Printer: n., A device that converts computer output into printed images, usually on paper. 

Priority System: n., A system that ranks WIC participants from the greatest need to receive WIC benefits to the lowest 
need. Once a local WIC Agency has reached its maximum caseload, vacancies are filled in the order of the 
following priority levels: Level 1- pregnant women, breastfeeding women, and infants determined to be at 
nutrition risk because of a nutrition-related medical condition; Level 2- infants up to six months of age whose 
mothers participated in WIC or could have participated and had a serious medical problem; Level 3- children at 
nutrition risk because of a nutrition-related medical problem; Level 4- pregnant or breastfeeding women and 
infants at nutrition risk because of an inadequate dietary pattern; Level 4- children at nutrition risk because of an 
inadequate dietary pattern; Level 5- Non-breastfeeding, postpartum women with any nutrition risk; Level 6- 
individuals at nutrition risk only because they are homeless or migrants, and current participants who, without 
WIC foods, could continue to have medical and/or dietary problems. 

Processing Standards: n., The time-frames for certifying applicants For example, local agencies shall notify applicants of 
their eligibility status no later than 20 calendar days from the date of application or, in cases of applicants at 
special nutritional risk (women eligible as Priority 1 participants and migrant farm workers and their family 
members), not later than 10 calendar days following the date of application. 

Program: (1) n., A system of services, opportunities, or projects, usually designed to meet a social need. (For example, the 
WIC program.) (2) n., A set of coded instructions that enable a machine, especially a computer, to perform a 
desired task. 

Proxy: (1) n., A person or concern authorized to act for another; an agent or substitute. (2) n., A person designated by a 
participant or the participant's parent or legal guardian to act on their behalf for all WIC program functions 
except the Certification process. The proxy is responsible for compliance with WIC program requirements for all 
activities that he or she may perform on behalf of the participant, parent, or legal guardian. Up to two proxies 
may be designated for a participant. A person shall not serve as a proxy for more than three WIC participants to 
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obtain and transact food instruments or to obtain supplemental foods on behalf of a participant. Parents, 
caretakers, or legal guardians applying on behalf of a child or an infant are not proxies. 

R 
Rebate: (1) n., A deduction from an amount to be paid or a return of part of an amount given in payment. (2) n., A 

discounted amount of the purchase price of a WIC item that is returned to the State or Tribal Agency on each 
item for which there is a rebate contract in place with a given manufacturer. The State or Tribal Agency bills the 
manufacturer either for the estimated or actual amount of rebated products purchased (usually monthly), 
depending on the capabilities of the WIC information system. 

Refer: v., To direct to a source for help or information. 

Referral: n., The act or an instance of referring; A recommendation to consult the person or concern referred to. 

Residence: n., The place in which one lives; a dwelling; a home. 

Return Merchandise Authorization: n., A Return Merchandise Authorization (RMA) is a transaction by which a 
consumer arranges to return a defective product to the product supplier to have the product repaired or replaced, 
or to receive a refund or a credit. This process is generally used to return products that are damaged in shipping 
or that become defective while still under warranty. The consumer generally calls a customer service telephone 
number, describes the issue with the product, and receives an RMA number or identifier which is written on the 
bill of lading or the packaging itself before it is shipped back to the supplier. This identifier alerts the supplier's 
shipping and receiving department of the situation and informs the handlers how to route the returned product. 
Specifics of the process may vary from supplier to supplier and from industry to industry. For example, the 
supplier may send the consumer RMA forms and packing labels, or even specialized packaging for return 
shipment. However, the process is referred to as an RMA, and the unique identifier that confirms the process is 
an RMA number. 

Right-click: v., To press down and release the right button on a pointing device, such as a mouse, while the pointer is 
positioned over an object in a GUI environment. The right mouse button, on a pointing device with more than 
one button, is typically assigned an ancillary function, while the left mouse button is assigned a primary function. 
For example, right-clicking is commonly used to display a menu for the GUI object clicked. 

RMA: See "Return Merchandise Authorization." 

S 
Sanction: n., A coercive measure, a penalty, that acts to ensure compliance or conformity. 

Semi-annual: adj., Occurring twice each year at regular intervals. 

Server: See "File Server." 

Service Site: n., A site designated by a local Agency as the location where WIC program services are offered. (Also known 
as a "WIC Clinic.") 

Shift key: n., A key on a computer keyboard that, when depressed, changes letters from lowercase to uppercase, changes 
the effect of a concurrently depressed function key in an application, or changes the effect of pushing a button 
on a pointing device (clicking). 

SOAP: n., Subjective, Objective, Assessment, and Plan; the sections that form the basic structure of a progress note. The 
Subjective section includes information gathered from the client. The Objective section includes information that 
can be measured. The Assessment section clarifies the basis for risk factor assignment and plans for intervention. 
The Plan section includes recommendations for treatment and any changes the client has agreed to make. 

Social Security Number: n., A federal identification number issued by the Social Security Administration of the United 
States government to participants of the Social Security program (a social welfare program). 

Software: n., A set of coded instructions that enable a machine, especially a computer, to perform a desired task. 

Special Formula: n., Exempt infant formula and medical foods. Special Formula may be prescribed for the following 
medical reasons: metabolic disorders, inborn errors of amino acid metabolism, gastrointestinal disorders, 
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malabsorption syndrome, allergies / formula tolerance, nutritional / medical disorders, and medical conditions 
which contraindicate the use of iron fortified formulas. 

SSN: See "Social Security Number." 

State Agency: n., A group of workers that are responsible for the local WIC program statewide. 

Statement: (A) n., A document showing credits and debits. (2) n., A statement of a person or concern's status with regard 
to money or wealth. 

Store: n., A physical building located at a permanent and fixed site that operates as a food retailer or freestanding 
pharmacy. 

Supplemental Foods: n., Foods that promote the health of individuals served by the WIC program as indicated by 
relevant nutrition science, public health concerns, and cultural eating patterns, including those foods containing 
nutrients determined by nutritional research to be lacking in the diets of pregnant women, breastfeeding women, 
postpartum women, infants, and children. 

System Tools: n., A collection of utilities used to manage system settings for the following WIC applications: Financial 
Management, Vendor Management, and Client Management (a suite of applications that includes the Clinic, State 
Office, and Central Administrative Site applications). System Tools are accessible through the applications' 
toolbars and through the File menu. 

T 
Tab key: n., A key on a computer keyboard that is used to advance the cursor to the next tab stop. 

TAFDC: See "Transitional Aid to Families with Dependent Children." 

TANF: See "Temporary Assistance to Needy Families." 

Temporary Assistance to Needy Families: n., A social welfare program (formerly AFDC or TAFDC) that provides 
temporary financial assistance to families with needy children who are deprived of support because of the 
absence or disability of one or both parents. 

Termination: n., The act of terminating or the condition of being terminated. Also See "Vendor Termination" and 
"Participant Termination." 

TIP Report: n., The Integrity Profile Report; an annual report about WIC vendors required by FNS that includes vendor 
characteristics, training, compliance activities, and sanctions. 

Transitional Aid to Families with Dependent Children: See "Aid to Families with Dependent Children." 

U 
Universal Product Code: n., The standard bar code printed on retail merchandise. It contains the vendor's identification 

number and the product number, which is read by passing the bar code over a scanner. 

UPC: See "Universal Product Code." 

USDA: n., The United States Department of Agriculture, which funds and oversees the WIC program through the Food 
and Nutrition Service. 

User ID: n., User Identification. Also see "User Name." 

User Name: n., A sequence of characters, different from a password, that is used as identification and is required when 
logging on to a secure computer system or network. 

V 
Vaccination: n., Inoculation with a vaccine in order to protect against a particular disease. 

Vaccine: n., A substance prepared from dead or living microorganisms that is introduced into the body through 
inoculation. The vaccine causes the development of antibodies, which produce immunity to the disease caused by 
the microorganism. 
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Value Enhanced Nutrition Assessment: n., An initiative, developed jointly by the Food and Nutrition Service (FNS) 
and the National WIC Association (NWA), to improve nutrition services in the WIC Program by establishing 
standards for the assessment process used to determine WIC eligibility and to individualize nutrition education, 
referrals, and food package tailoring. VENA is part of the larger process known as Revitalizing Quality Nutrition 
Services (RQNS) in WIC. 

VENA: n., See "Value Enhanced Nutrition Assessment." 

Vendor: n., A concern, such as a grocery store, where WIC food instrument checks or vouchers are redeemed; a grocery 
retailer authorized to accept WIC food instrument checks in exchange for WIC approved food items. 

Vendor Disqualification: n., The act of disqualifying a WIC vendor. A vendor may be disqualified for violating the terms 
of the vendor agreement. When a vendor is disqualified, the vendor is suspended from participation and the 
vendor's agreement may be terminated in due course. 

Vendor Investigation: n., A process to identify and investigate high-risk vendors. It includes the analysis of a vendor's 
redemption data and a review of complaints about the vendor. Compliance Buys and inventory audits are two 
primary means of investigation. 

Vendor Termination: n., The act of terminating a WIC vendor. When a vendor is terminated, the vendor can no longer 
accept WIC food instrument checks in exchange for WIC approved food items. A vendor may be terminated for 
violating the terms of the vendor agreement. The following is a list of some of the reasons for which a vendor 
may be terminated: the actual or attempted sale or transfer of the vendor agreement, the WIC authorization, or 
WIC vendor number; the death of the vendor (if an individual); the voluntary or involuntary dissolution of a 
vendor Corporation, partnership, limited partnership, unincorporated association or firm; or being disqualified 
from participation in the WIC program. A vendor must reapply for participation after being terminated. 

Verification of Certification: n., The document that is used to verify a WIC participant's Certification status. The 
document allows its bearer to continue receiving WIC benefits until the end of his or her Certification period 
when the participant transfers out of the local Agency. 

VOC: See "Verification of Certification." 

Voucher: See "Food Instrument." 

W 
Waiting List: n., A list used to track participants of low priority. Once a local WIC Agency has reached its maximum 

caseload, a freeze is placed on enrollment, and participants of low priority are placed on a waiting list. As 
program vacancies open up, participants are provided WIC benefits in the order of their priority level. 

Waiver: n., An exemption or release from an obligation, rule, or penalty. 

Web: See "World Wide Web." 

Web Browser: n., A computer program that serves as a front end to the World Wide Web on the Internet. A computer 
program used to view HTML documents. For example, Internet Explorer, Navigator, Firefox, and Opera are 
widely used web browsers. 

Web Page: n., A document consisting of an HTML file and any related files, located on the World Wide Web, and often 
hyperlinked to other documents on the Web. 

White (not of Hispanic origin): n., A person having origins in any of the original peoples of Europe, North Africa, or 
the Middle East. 

WIC Agency: n., A public or private, nonprofit health or human service Agency or tribal health Agency which provides 
WIC health services, either directly, through contract, or through referral to a health provider. 

WIC Category: n., WIC categories are used to categorize WIC participant's according to their needs. The WIC program 
serves the following five categories of participants: Infant, Child, Pregnant, Breastfeeding, and Non-
breastfeeding. 

WIC Clinic: n., A site designated by a WIC Agency as a location where WIC program services are offered. (Also known 
as a "Service Site.") 
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WIC Program: n., The Special Supplemental Food Program for Women, Infants and Children (WIC) [authorized by 
Section 17 of the Child Nutrition Act of 1966, as amended]; a federally funded program established under the 
Child Nutrition Act of 1966, amended, to provide supplemental foods, nutrition education, and access to health 
care for low-income pregnant, postpartum and lactating women, and infants and children up to five years of age. 
To qualify for WIC, applicants must meet categorical, income, and nutrition risk eligibility requirements. 

Workstation: n., A desktop or laptop computer, sometimes attached to a network. A generic term for a user's machine 
(client machine). 

World Wide Web: n., The complete set of documents (web pages) residing on all Internet servers that use the HTTP 
protocol, accessible to users through a simple point-and-click hypertext system. 
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